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Notices

Federal Communications Commission Statement

This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions:

+ This device may not cause harmful interference, and

+ This device must accept any interference received including interference that
may cause undesired operation.

This equipment has been tested and found to comply with the limits for a

Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with manufacturer’s
instructions, may cause harmful interference to radio communications. However,
there is no guarantee that interference will not occur in a particular installation. If
this equipment does cause harmful interference to radio or television reception,
which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following
measures:

+ Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.

+ Connect the equipment to an outlet on a circuit different from that to which the
receiver is connected.

+ Consult the dealer or an experienced radio/TV technician for help.

f The use of shielded cables for connection of the monitor to the graphics card is
required to assure compliance with FCC regulations. Changes or modifications
to this unit not expressly approved by the party responsible for compliance
could void the user’s authority to operate this equipment.

Canadian Department of Communications Statement

This digital apparatus does not exceed the Class B limits for radio noise emissions
from digital apparatus set out in the Radio Interference Regulations of the
Canadian Department of Communications.

This class B digital apparatus complies with Canadian ICES-003.

vii
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Safety information

Electrical safety

To prevent electrical shock hazard, disconnect the power cable from the
electrical outlet before relocating the system.

When adding or removing devices to or from the system, ensure that the
power cables for the devices are unplugged before the signal cables are
connected. If possible, disconnect all power cables from the existing system
before you add a device.

Before connecting or removing signal cables from the motherboard, ensure
that all power cables are unplugged.

Seek professional assistance before using an adpater or extension cord.
These devices could interrupt the grounding circuit.

Make sure that your power supply is set to the correct voltage in your area.
If you are not sure about the voltage of the electrical outlet you are using,
contact your local power company.

If the power supply is broken, do not try to fix it by yourself. Contact a
qualified service technician or your retailer.

Operation safety

Before installing the motherboard and adding devices on it, carefully read all
the manuals that came with the package.

Before using the product, make sure all cables are correctly connected and the
power cables are not damaged. If you detect any damage, contact your dealer
immediately.

To avoid short circuits, keep paper clips, screws, and staples away from
connectors, slots, sockets and circuitry.

Avoid dust, humidity, and temperature extremes. Do not place the product in
any area where it may become wet.

Place the product on a stable surface.

If you encounter technical problems with the product, contact a qualified
service technician or your retailer.

and electronic equipment) should not be placed in municipal waste. Check local

E This symbol of the crossed out wheeled bin indicates that the product (electrical

— regulations for disposal of electronic products.



About this guide

This user guide contains the information you need when installing and configuring
the motherboard.

How this guide is organized

This guide contains the following parts:

Chapter 1: Product introduction

This chapter describes the features of the motherboard and the new
technology it supports.

Chapter 2: Hardware information

This chapter lists the hardware setup procedures that you have to perform
when installing system components. It includes description of the switches,
jumpers, and connectors on the motherboard.

Chapter 3: Powering up

This chapter describes the power up sequence and ways of shutting down
the system.

Chapter 4: BIOS setup

This chapter tells how to change system settings through the BIOS Setup
menus. Detailed descriptions of the BIOS parameters are also provided.
Chapter 5: Software support

This chapter describes the contents of the support DVD that comes with the
motherboard package.

Chapter 6: NVIDIA® SLI™ technology support

This chapter tells how to install SLI-ready PCI Express graphics cards.

Where to find more information

Refer to the following sources for additional information and for product and
software updates.

1.

ASUS websites

The ASUS website provides updated information on ASUS hardware and
software products. Refer to the ASUS contact information.

Optional documentation

Your product package may include optional documentation, such as warranty
flyers, that may have been added by your dealer. These documents are not
part of the standard package.



Conventions used in this guide

To make sure that you perform certain tasks properly, take note of the following
symbols used throughout this manual.

’ DANGER/WARNING: Information to prevent injury to yourself
é when trying to complete a task.

’ CAUTION: Information to prevent damage to the components
. when trying to complete a task.

R IMPORTANT: Instructions that you MUST follow to complete a

task.

%f NOTE: Tips and additional information to help you complete a

task.

Typography
Bold text
Italics

<Key>

<Key1+Key2+Key3>

Command

Indicates a menu or an item to select.

Used to emphasize a word or a phrase.

Keys enclosed in the less-than and greater-than sign
means that you must press the enclosed key.

Example: <Enter> means that you must press the
Enter or Return key.

If you must press two or more keys simultaneously, the
key names are linked with a plus sign (+).

Example: <Ctrl+Alt+D>

Means that you must type the command exactly

as shown, then supply the required item or value
enclosed in brackets.

Example: At the DOS prompt, type the command line:

awdflash M2N32SLI.bin



M2N32-SLI Premium Vista Edition
specifications summary

Chipset

System bus
Memory

Expansion slots

Scalable Link Interface
(SLI™)

Storage

Socket AM2 for AMD Athlon™ 64 X2 / Athlon™64 / Athlon™
64 FX / Sempron™ processor

Supports AMD Cool ‘n’ Quiet™ Technology

AMDG64 architecture enables simultaneous 32-bit and
64-bit computing

AMD LIVE!™ Ready

NVIDIA® nForce® 590 SLI™ MCP
NVIDIA® LinkBoost™ Technology

2000 /1600 MT/s

Dual-channel memory architecture
- 4 x 240-pin DIMM sockets support unbufferred
ECC/non-ECC DDR2 800/667/533 MHz memory
modules
- Supports up to 8 GB system memory

2 x PCI Express™ x16 slots with NVIDIA® SLI™ support
at full x16, x16 speed

1 x PCI Express™ x4 slot (supports PCI Express™ x4 or
x1 card)

1 x PCI Express™ x1 slot

2 x PCl 2.2 slots

Supports two identical NVIDIA® SLI™-ready graphics
cards, both at x16 mode
ASUS two-slot thermal design

NVIDIA® nForce® 590 SLI™ MCP supports:

- 1 x IDE connector for up to two Ultra DMA
133/100/66/33 devices

- 6 x Serial ATA 3.0 Gb/s connectors support six
Serial ATA devices

- RAID 0, RAID1, RAID 0+1, RAID 5, and JBOD
configurations spanning across Serial ATA drives
via the onboard NVIDIA® MediaShield™ RAID
controller

Silicon Image® 3132 Serial ATA controller supports:
- 1 x Internal Serial ATA 3.0 Gb/s
- 1 x External Serial ATA 3.0 Gb/s on the rear panel
(SATA-On-The-Go)
- RAID 0, RAID 1, and JBOD configuration

Dual Gigabit LAN controllers support NVIDIA® DualNet
technology

NVIDIA® nForce® 590 SLI™ MCP built-in dual Gigabit
MAC with external Marvell® PHY
- Supports Teaming and Fail-Over functions
- Supports TCP/IP Acceleration

(continued on the next page)
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M2N32-SLI Premium Vista Edition
specifications summary

High Definition Audio

IEEE 1394

ASUS Al Lifestyle
features

Other features

SoundMAX® ADI AD1988B 8-channel CODEC

Supports Jack-Sensing, Enumeration, Multi-Streaming,
and Jack-Retasking Technology

Optical and Coaxial S/PDIF Out back /0O ports

TI 1394 controller supports:
- 2 x |[EEE 1394a connectors (1 at mid-board; 1 on
the rear panel)

8 x USB 2.0 ports (4 at mid-board; 4 on the rear panel)

ASUS Al Lifestyle Vista Edition features:
- ScreenDUO
- Al Remote
- ASAP (ASUS Accelerated Propeller)
- TPM Support (the module is purchased separately)
- AP Trigger
*ASUS ScreenDUO, Al Remote, and TPM can run both
Windows® Vista and XP
ASUS Quiet Thermal Solution:
- ASUS Al Gear
- ASUS Al Nap
- ASUS 8-Phase Power Design
- ASUS Fanless Design: Heat-pipe solution & Stack
Cool 2
- ASUS Q-Fan 2
- ASUS optional fan for water-cooling or passive
cooling only
ASUS Crystal Sound
- ASUS Array Microphone
- Noise Filer
ASUS EZ DIY
- ASUS Q-Connector
- ASUS CrashFree BIOS 3
- ASUS EZ Flash 2

ASUS MyLogo3

(continued on the next page)




M2N32-SLI Premium Vista Edition
specifications summary

ASUS Exclusive
Overclocking features

Rear panel I/0 ports

Intelligent overclocking tools:
- AINOS™ (Non-delay Overclocking System)
- Al Overclocking (intelligent CPU frequency tuner)
- Al Clock Skew
- ASUS 0.C. Profile: overclocking configuration-sharing
tool
Precision Tweaker:
- vDIMM: 25-step DRAM voltage control
- vCore: Adjustable CPU voltage at 0.0125V
increment
- Stepless Frequency Selection (SFS) allows FSB
tuning from 200 MHz up to 400 MHz at 1 MHz
increment
- PCI Express x16 frequency allows PCI Express x16
frequency tuning from 100 MHz to 200 MHz at 1
MHz increment
Overclocking protection:
- ASUS C.P.R. (CPU Parameter Recall)
ASUS Al Booster Utility
Adjustable FSB/DDR2 ratio; fixed PCI/PCle frequencies

1 x PS/2 keyboard port (purple)

1 x PS/2 mouse port (green)

1 x Serial (COM1) port

1 x IEEE 1394a port

1 x Optical + 1 x Coaxial S/PDIF Out port
1 x External SATA port

2 x LAN (RJ-45) ports

4 x USB 2.0/1.1 ports

8-channel audio ports

(continued on the next page)
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M2N32-SLI Premium Vista Edition
specifications summary

Internal connectors

BIOS features
Manageability
Accessories

Support CD contents

Form factor

2 x USB 2.0 connectors support four additional USB 2.0
ports

1 x Floppy disk drive connector

1 x IDE connector for two devices

7 x Serial ATA connectors

1 x CPU /4 x Chassis / 1 x Chipset / 1 x Power fan
connectors

1 x IEEE 1394a connector

1 x Parallel connector

1 x S/PDIF Out connector

1 x TPM connector

Chassis intrusion connector

Front panel audio connector

CD audio in connector

24-pin ATX power connector

4-pin ATX 12 V power connector

System panel connector

8 Mb AWARD BIOS, PnP, DMI 2.0, WfM2.0, SM BIOS 2.3
WOL by PME, WOR by PME, Chassis intrusion, PXE

1 x SLI bridge

1 x ASUS Array Mic

1 x ASUS optional fan

1 x ASUS Q-Connector kit (USB, 1394, system panel;
Retail version only)

1 x UltraDMA 133/100/66 cable

1 x Floppy disk drive cable

6 x SATA cables

3 x SATA power cables for 6 devices

1 x 2-port USB 2.0 module

1 x IEEE 1394a module

1 x 1/0 shield

ScreenDUO (Retail version only)

Al Remote (Retail version only)

User’s manual

Drivers

ASUS Al Suite

ASUS PC Probe I

ASUS Update

NVIDIA® MediaShield™ RAID
Anti-virus Utility (OEM version)

ATX form factor: 12in x 9.6 in (30.5 cm x 24.5 cm)

*Specifications are subject to change without notice.
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1.1 Welcome!
Thank you for buying an ASUS® M2N32-SLI Premium Vista Edition motherboard!

The motherboard delivers a host of new features and the latest technologies,
making it another standout in the long line of ASUS quality motherboards!

Before you start installing the motherboard, and hardware devices on it, check the
items in your package with the list below.

1.2 Package contents

Check your motherboard package for the following items.

Motherboard
1/0 modules

Cables

Accessories

Application DVD
Documentation

ASUS M2N32-SLI Premium Vista Edition

IEEE 1394a module
1 x 2-port USB 2.0 module

6 x Serial ATA cables

3 x Serial ATA power cables for six devices
1 x Ultra DMA 133/100/66 cable

1 x Floppy disk drive cable

I/0 shield

ASUS SLI™ Bridge

ASUS Array Mic

ASUS Optional Fan

ASUS Q-Connector Kit (USB, 1394, system panel;
Retail version only)

ScreenDUO Kit (ScreenDUO, user guide, support
CD, USB cable; Retail version only)

Al Remote (Retail version only)

ASUS motherboard support DVD
User guide

/ If any of the above items is damaged or missing, contact your retailer.

ASUS M2N32-SLI Premium Vista Edition
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1.3 Special features
1.3.1 Product highlights

Latest processor technology ﬁ

The motherboard comes with a 940-pin AM2 socket that supports AMD Athlon™
64 X2/Athlon™ 64/Athlon™ 64 FX/Sempron™ processor. With an integrated low-
latency high-bandwidth memory controller and a highly scalable HyperTransport™
technology-based system bus, the motherboard provides a powerful platform for
your diverse computing needs, increased office productivity, and enhanced digital
media experience. See page 2-7 for details.

NVIDIA® Scalable Link Interface (SLI™) SL!

The NVIDIA® Scalable Link Interface (SLI™) technology allows two graphics
processing units (GPUs) in a single system. This technology takes advantage of
the PCI Express™ bus architecture and features intelligent hardware and software
solutions that allows multiple GPUs to work together and achieve exceptional
graphics performance.

NVIDIA nForce® 590 SLI™ (NVIDIA LinkBoost™ certlfled) -

NVIDIA nForce® 590 SLI™ media and communication processors (MCPs) deliver
the tools and performance PC enthusiasts demand. When combined with selected
NVIDIA GeForce graphics cards and other system components, you get automatic
access to faster bus speeds. Ready for system overclocking and greater data
throughput.

Dual-Core CPU g

The advanced processing technology contains two physical CPU cores with
individually dedicated L2 caches to satisfy the rising demand for more powerful
processing capability.

Dual-Channel DDR2 800 E_-]

DDR2 is the next generation memory technology that replaces the current DDR.
With the highest speed up to 800 MHz, DDR2 memory provides great performance
for 3D graphics and other memory demanding applicaitons. See page 2-13 and
2-14 for details.

PCI Express™ interface ex PG'

The motherboard fully supports PCI Express, the latest I/O interconnect technology
that speeds up the PCI bus. PCI Express features point-to-point serial
interconnections between devices and allows higher clockspeeds by carrying data
in packets. This high speed interface is software compatible with existing PCI
specifications. See page 2-21 for details.

Chapter 1: Product introduction



T
Serial ATA 3.0 Gb/s technology and SATA-On-The-Go EEE M d

The motherboard fully supports the Serial ATA 3.0 Gb/s technology through the Serial
ATA interfaces and the NVIDIA® nForce® 590 SLI™ chipset. The Serial ATA 3 Gb/s
specification provides twice the bandwidth of the current Serial ATA products with

a host of new features, including Nativa Command Queueing (NCQ), and Power
Management (PM) Implementation Algorithm. Serial ATA allows for thinner, more
flexible cables with lower pin count and reduced voltage required. Leveraging these
Serial ATA 3.0 Gb/s features is the SATA-On-The-Go. Supported by the Silicon
Image Sil3132 Serial ATA controller, two Serial ATA 3.0 Gb/s connectors (one at mid-
board and one on the rear panel) provide smart setup, and hot-plug function. See
page 2-24, 2-27, and 2-28 for details.

Dual RAID solution D

Onboard RAID controllers provide the motherboard with dual-RAID functionality that
allows you to select the best RAID solution using Serial ATA devices.

The NVIDIA® nForce® 590 SLI™ chipset allows RAID 0, RAID 1, RAID 0+1, RAID
5, and JBOD configuration for six SATA 3.0 Gb/s connector. See pages 2-24.

The Silicon Image® Sil3132 controller supports two additional Serial ATA 3.0 Gb/s
connectors (one at mid-board and one on the rear panel) and allows RAID 0, RAID
1, and JBOD configurations on these ports. See pages 2-28 for details.

IEEE 1394a support k4

The IEEE 1394a interface provides high-speed and flexible PC connectivity to a
wide range of peripherals and devices compliant to the IEEE 1394a standard. The
IEEE 1394a interface allows up to 400 Mbps transfer rates through simple, low-
cost, high-bandwidth asynchronous (real-time) data interfacing between computers,
peripherals, and consumer electronic devices such as camcorders, VCRs, printers,
TVs, and digital cameras. See page 2-23 and 2-29 for details.

High Definition Audio [:
Enjoy high-end sound quality on your PC! The onboard 8-channel HD audio (High
Definition Audio, previously codenamed Azalia) CODEC enables high-quality
192KHz/24-bit audio output, jack-sensing feature, retasking functions and multi-
streaming technology that simultaneously sends different audio streams to different
destinations. You can now talk to your partners on the headphone while playing

multi-channel network games. See page 2-23 and 2-24 for details.
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USB 2.0 technology ﬁ'ggf_*-

The motherboard implements the Universal Serial Bus (USB) 2.0 specification,
dramatically increasing the connection speed from the 12 Mbps bandwidth on USB
1.1 to a fast 480 Mbps on USB 2.0. USB 2.0 is backward compatible with USB 1.1.
See page 2-24 and 2-29 for details.

Dual Gigabit LAN solution E

The motherboard comes with dual Gigabit LAN controllers to provide the total
solution for your networking needs. These network controllers provide faster data
bandwidth for your wired or wireless Internet, LAN, and file sharing requirements.
See page 2-23 for details.

AMD Cool ‘n’ Quiet Technology ﬁ

The motherboard supports the AMD Cool ‘n’ Quiet Technology, which monitors
system operation and automatically adjusts CPU voltage and frequency for a cool
and quiet operating environment. See page 4-27 for details.

[\
1.3.2  ASUS Al Lifestyle features /A m‘!

| |
Al Remote |

The revolutionary Al Remote gives you unprecedented control from the comfort of
your couch. With just a touch of the button, you can quickly do your usual computer
activities such as turn ON/OFF your PC, launch your favorite applications by
enabling AP Trigger function, or control Al Gear and Al Nap. The Al Remote also
gives you the comfort of a traditional remote on media player. Have an Al Remote
in your hand and do more with your PC from a distance! See page 5-31 for details.

=

ASAP (ASUS Accelerated Propeller) M

ASAP gets you to your destination ASAP. ASAP supports the Windows®
ReadyBoost™ technology which improves system performance under Windows®
Vista. Enjoy greater efficiency and get more productivity out of your system. See
page 5-39 for details.
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[
AP Trigger i

The AP Trigger allows you to quickly boot or resume directly into media or into
your favorite applications. With just a touch of the button on the Al Remote
controller, you can quickly turn on your PC and launch predefined applications
simultaneously!

ScreenDUO

The ScreenDUO provides a second display panel to enable you to conveniently
view important information without having to start up your PC. The ScreenDUO
synchronizes information from the PC or websites, displays RSS messages,
meeting schedules and other important information. This saves you the time and
the hassle to turn on your PC each time you want to view vital information.

TPM Support [}

This motherboard supports the Trusted Platform Module (TPM), which provides
you with enhanced data protection via high-level encryption/decryption and
ensures platform integrity. The TPM meets the Windows?® Vista BitLocker™ Drive
Encryption hardware requirement for a more secure working environment. See
page 2-34 and 4-42 for details.

/ The TPM module is purchased separately. Use the ASUS TPM module ONLY.

Al Gear

Al Gear allows users to choose from four modes to adjust CPU and Vcore voltage,
minimizing noise and power consumption. Users can choose the mode that best
suits their needs. See page 5-27 for details.

Al Nap @

With Al Nap, the system can continue running at minimum power and noise
when the user is temporarily away. To wake the system and return to the OS
environment, simply click the mouse or press a key. See page 5-28 for details.

ASUS Crystal Sound

This feature can enhance speech-centric applications like Skype, online game,
video conference and recording.

ASUS M2N32-SLI Premium Vista Edition
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ASUS Array Mic u

The Bundled Superbeam Array Microphone receives only the sound
coming from the reception cone and ignores the sounds coming from other
directions. This mechanism eliminates a large number of interferences,
including neighboring speakers and reverberations. It also uses advanced
de-reverberation techniques to reduce echo and minimize its effect on the
speech engine. This feature can enchance speech-centric applications like
Skype, online game, video conference, and recording. See page 5-17 for
details.

-E
Noise Filter -4
This feature detects repetitive and stationary noises (non-voice signals) like
computer fans, air conditioners, and other background noises then eliminates
it in the incoming audio stream while recording. See page 5-17 for details.

Advanced Thermal Design

ASUS Stack Cool 2 E

ASUS Stack Cool 2 is a fan-less and zero-noise cooling solution that lowers
the temperature of critical heat generating components. The motherboard
uses a special design on the printed circuit board (PCB) to dissipate heat that
critical components generate. See page 2-3 for details.

8-Phase Power Design f -]

The ASUS 8-Phase Power Design prolongs CPU lifespan and keeps the
system stable by preventing high power stress to the CPU and power supply
module. The design ensures high efficiency operation to generate less heat
compared with conventional power solutions, thus achieving cool system
environment and making this motherboard ideal for overclocking.

o
Fanless Design and Heat-pipe | I ELT A
The ASUS fanless design allows multi-directional heat flow from major
thermal sources in the motherboard to lower overall system temperature,
resulting in quieter operation and longer system life. ASUS has devoted
special efforts to addressing the thermal issues across the motherboard,
and most notably in the following areas: CPU, power, VGA, Northbridge and
Southbridge. The heat pipe, heatsink, and strategic board layout were tailor
made to dissipate heat in the most efficient manner.
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1.3.3  ASUS special features

ASUS CrashFree BIOS 3 B

The ASUS CrashFree BIOS 3 allows users to restore corrupted BIOS data from a
USB flash disk containing the BIOS file. This utility saves users the cost and hassle
of buying a replacement BIOS chip. See page 4-9 for details.

ASUS EZ Flash 2 Q

EZ Flash 2 is a user-friendly BIOS update utility. Simply press the predefined
hotkey to launch the utility and update the BIOS without entering the OS. Update
your BIOS easily without preparing a bootable diskette or using an OS-based flash
utility. See page 4-5 for details.

ASUS MyLogo 3 E

ASUS My Logo 3 is the new feature present in the motherboard that allows you
to personalize and add style to your system with customizable and animated boot
logos. See page 5-9 for details.

ASUS Q-Connector Li

You can use ASUS Q-Connector to connect / disconnect chassis from panel cables
by only a few easy steps. See page 2-36 for details.

C.PR. (CPU Parameter Recall) VGIiR#

The C.P.R. feature of the motherboard BIOS allows automatic re-setting to the
BIOS default settings in case the system hangs due to overclocking. When the
system hangs due to overclocking, C.P.R. eliminates the need to open the system
chassis and clear the RTC data. Simply shut down and reboot the system, and the
BIOS automatically restores the CPU default setting for each parameter.

Green ASUS ﬂ

This motherboard and its packaging comply with the European Union’s Restriction
on the use of Hazardous Substances (RoHS). This is in line with the ASUS vision
of creating environment-friendly and recyclable products/packaging to safeguard
consumers’ health while minimizing the impact on the environment.

ASUS M2N32-SLI Premium Vista Edition
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1.3.4  ASUS Intelligent Overclocking features
ASUS 0.C. Profile

The motherboard features the ASUS O.C. Profile that allows users to conveniently
store or load multiple BIOS settings. The BIOS settings can be stored in the
CMOS or a separate file, giving users freedom to share and distribute their favorite
settings. See page 4-43 for details.

Al NOS™ (Non-Delay Overclocking System) E N

Applications such as 3D games and video editing demand a huge chunk of
system resource. Inject “nitrous oxide” into your CPU! The patented Al NOS™
(Non-delay Overclocking System) technology intelligently detects system load
and automatically boosts performance for the most demanding tasks. Unlike other
dynamic overclocking techniques, Al NOS™ reacts much faster to satisfy your
unending need for speeds. See page 4-20 for details.

Al Clock Skew E

Al Clock Skew automatically skews the memory clock signal timing and improves
memory overclocking capability by 10 to 15%, depending on the memory
features when users overclock memory frequency. Users can enjoy better
memory overclocking without strenuously fine-tuning the clock signal timing.

For professional users, they can still adjust each memory channel’s clock signal
separately to reach the highest memory frequency.

117

Precision Tweaker "'

It offers ways to raise system performance inch-by-inch and step-by-step to
achieve maximum performance! This is about getting the most out of your machine
and taking pride in your customized computer.

vDIMM takes control of how much power is going into the memory modules. ASUS
gives you 25-step voltage control to the DIMM

vCore finds out “exactly” how much power your CPU needs. Fine-tune it with
0.0125 volts at a time!

SFS (Stepless Frequency Selection) allows
- FSB tuning from 200MHz up to 400MHz at 1MHz increment
- PCI Express frequency tuning from 100MHz up to 200MHz at 1MHz increment
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1.3.5

ASUS features and the supporting OS

Refer to the following table for the OS that supports ASUS features.

ScreenDUO
Al Remote

AP Trigger

Al Gear

Al Booster
Array Mic
Noise Filter
SoundMAX
PC Probe I

7

Win 2000

Functi

XP 32bit

\
\

v

XP 64bit

on as USB Flash only

Vista 32bit

Vista 64bit

< the driver from the ASUS website (support.asus.com).

ASUS M2N32-SLI Premium Vista Edition
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This chapter lists the hardware setup
procedures that you have to perform
when installing system components. It
includes description of the jumpers and
connectors on the motherboard.

Hardware
information
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23
24
25
2.6
27
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Motherboard overview............cocuverinmrssenesessnsanans 2-2
Central Processing Unit (CPU) ........cocenrninnnnesnncnens “2-7

System memory
Expansion slots
Jumper
Connectors
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2.1 Before you proceed
Take note of the following precautions before you install motherboard components
or change any motherboard settings.

' + Unplug the power cord from the wall socket before touching any
° component.

Use a grounded wrist strap or touch a safely grounded object or to a metal
object, such as the power supply case, before handling components to
avoid damaging them due to static electricity.

+ Hold components by the edges to avoid touching the ICs on them.

Whenever you uninstall any component, place it on a grounded antistatic
pad or in the bag that came with the component.

Before you install or remove any component, ensure that the ATX power
supply is switched off or the power cord is detached from the power
supply. Failure to do so may cause severe damage to the motherboard,
peripherals, and/or components.

Onboard LED

The motherboard comes with a standby power LED. The green LED lights up
to indicate that the system is ON, in sleep mode, or in soft-off mode. This is a
reminder that you should shut down the system and unplug the power cable
before removing or plugging in any motherboard component. The illustration
below shows the location of the onboard LED.

SB_PWR

ON OFF
Standy Powered
Power off

M2N32-SLI PREMIUM
Onboard LED connector
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2.2 Motherboard overview

Before you install the motherboard, study the configuration of your chassis to
ensure that the motherboard fits into it.

E Make sure to unplug the power cord before installing or removing the
motherboard. Failure to do so can cause you physical injury and damage
motherboard components.

2.2.1 Placement direction

When installing the motherboard, make sure that you place it into the chassis in
the correct orientation. The edge with external ports goes to the rear part of the
chassis as indicated in the image below.

2.2.2 Screw holes

Place nine (9) screws into the holes indicated by circles to secure the motherboard
to the chassis.

' Do not overtighten the screws! Doing so can damage the motherboard.

Place this side towards
the rear of the chassis

i M2N32-SLI PREMIUM
o= ==
==
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2.2.3 ASUS Stack Cool 2

The motherboard comes with the ASUS Stack Cool 2 cooling solution that lowers
the temperature of critical heat generating components by 20°C. The motherboard
uses a special design on the printed circuit board (PCB) to dissipate heat that
critical components generate.

ASUS M2N32-SLI Premium Vista Edition



24

Motherboard layout

’ 24.5cm (9.6in)
I
PS2/2KBMS
T:Mouse SATA_RAID2
B:Keyboard
RS m ‘ DDR2 DIMM_B2 (64 bit, 240-pin module) |
< \ DDR2 DIMM_A2 (64 bit, 240-pin module) \
8 5 E \ DDR2 DIMM_B1 (64 bit, 240-pin module) |
O H CPU_FAN - -
Lt \ DDR2 DIMM_A1 (64 bit, 240-pin module) | .
a
ESATA_1394 E
LAN1_USB12 SOCKET AM2
LAN2_USB34 - -
['4
H
[
x
AUDIO 5
USB910_ASAP
=i
. ®
E ATX12V nVIdIa
E DD C51XE
= =
. CHA_FAN1 ‘
CHA_FANE PCIEX16_1 | crans2v
I Lithium Cell
CMOS Power
CLRTC ==
i PCIEX4_1 I H
H CH‘FLFANE
CD (=
PCIEX1_1 Vidia®
nVidia SATAS SATA6
[EEEl{= anrp M2N32-SLI PREMIUM
T[] SPDIF_OUT MCPSSPXE SATA3 SATA4
‘ PCIEX1 6—2 ’:/ SATA1 SATA2
prp————
Vd— "
‘ PCI1 ‘ CHASSISEImEl ~ CHA_FAN3
[TsB43AB22A] s CHA_FAN4
SB_PWR uper
PCI2 ‘ BIOS
1E1394_1 UsB78 USB56 TPM LPT
B 5 ELPTILETER

Refer to 2.7 Connectors for more information about rear panel connectors and

internal connectors.

30.5cm (12in)
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2.2.5 Layout contents

Slots Page

1. DDR2 DIMM slots 2-13
2. PClI slots 2-21
3. PCI Express x 4 slot 2-21
4. PCI Express x 1 slot 2-21
5. PCI Express x16 slots 2-21
Jumper Page
1. Clear RTC RAM (3-pin CLRTC) 2-22

Rear panel connectors Page

1. PS/2 mouse port (green) 2-23
2. Serial (COM) port 2-23
3. IEEE 1394a port 2-23
4. LAN 1/2 (RJ-45) port. 2-23
5. Center/Subwoofer port (orange) 2-23
6. Rear Speaker Out port (black) 2-23
7. Line In port (light blue) 2-23
8. Line Out port (lime) 2-23
9. Microphone port (pink) 2-24
10. Side Speaker Out port (gray) 2-24
11. USB 2.0 ports 1 and 2, 3 and 4 2-24
12. External SATA port 2-24
13. Optical S/PDIF Out port 2-25
14. Coaxial S/PDIF Out port 2-25
15. PS/2 keyboard port (purple) 2-25
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Internal connectors Page

1. Floppy disk drive connector (34-1 pin FLOPPY) 2-26
2. IDE connector (40-1 pin PRI_IDE) 2-26
3. NVIDIA® nForce® 590 SLI Southbridge Serial ATA 2-27
connectors (7-pin SATA1 [red], SATA2 [red], SATAS [red],
SATAA4 [red], SATAS5 [red], SATAS [red])
4. Silicon Image® Serial ATA RAID connector (7-pin SATA_RAID2) 2-28
5. USB connectors (10-1 pin USB56, USB78, USB910_ASAP) 2-29
6. IEEE 1394a port connector (10-1 pin [E1394_1) 2-29
7. CPU, chassis, power, and chipset fan connectors 2-30
(4-pin CPU_FAN, 3-pin CHA_FAN1, 3-pin CHA_FAN2,
3-pin CHA_FANS, 3-pin CHA_FANA4, 3-pin PWR_FAN,
3-pin CHIP_FAN)
8. Chassis intrusion connector (4-1 pin CHASSIS) 2-31
9. ATX power connectors (24-pin EATXPWR, 4-pin ATX12V) 2-31
10. Front panel audio connector (10-1 pin AAFP) 2-32
11. Optical drive audio connector (4-pin CD) 2-33
12. Parallel port connector (26-1 pin LPT) 2-33
13. Digital audio connector (4-1 pin SPDIF) 2-34
14. TPM connectoe (20-1 pin TPM) 2-34
15. System panel connector (20-8-pin PANEL) 2-35
System power LED (2-pin PLED)
Hard disk drive activity LED (2-pin IDE_LED)
. System warning speaker (4-pin SPEAKER)
. ATX power button/soft-off button (2-pin PWRSW)
Reset button (2-pin RESET)
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2.3 Central Processing Unit (CPU)

The motherboard comes with a 940-pin AM2 socket designed for the Athlon™ 64
X2/Athlon™ 64/Athlon™ 64FX/Sempron™ processor.

) ' The AM2 socket has a different pinout from the 940-pin socket designed for
e the AMD Opteron processor. Make sure you use a CPU designed for the AM2
socket. The CPU fits in only one correct orientation. DO NOT force the CPU into
the socket to prevent bending the connectors on the socket and damaging the
CPU!

2.3.1 Installing the CPU
To install a CPU:

1. Locate the CPU socket on the motherboard.

M2N32-SLI PREMIUM
CPU Socket AM2

2. Unlock the socket by pressing the
lever sideways, then lift it up to a
90° angle.

Socket lever

k Make sure that the socket lever is lifted up to a 90° angle; otherwise, the CPU
will not fit in completely.

ASUS M2N32-SLI Premium Vista Edition
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Position the CPU above the socket
such that the CPU corner with the
gold triangle matches the socket
corner with a small triangle.

Carefully insert the CPU into the
socket until it fits in place.

Gold triangle

Small triangle

When the CPU is in place, push
down the socket lever to secure the
CPU. The lever clicks on the side tab
to indicate that it is locked.

Install a CPU heatsink and fan
following the instructions that came
with the heatsink package.
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23.2 Installing the heatsink and fan

The AMD Athlon™ 64FX/Athlon™ 64/Athlon™ 64 X2/Sempron™ processor requires a
specially designed heatsink and fan assembly to ensure optimum thermal condition
and performance.

R Make sure that you use only AMD-certified heatsink and fan assembly.

To install the CPU heatsink and fan:

1. Place the heatsink on top of the installed CPU, making sure that the heatsink
fits properly on the retention module base.

% = The retention module base is already installed on the motherboard upon
L purchase.

*  You do not have to remove the retention module base when installing the
CPU or installing other motherboard components.

+  If you purchased a separate CPU heatsink and fan assembly, make sure
that a Thermal Interface Material is properly applied to the CPU heatsink or
CPU before you install the heatsink and fan assembly.

CPU fan

CPU heatsink

Retention module base

Retention bracket

Retention bracket lock

% Your boxed CPU heatsink and fan assembly should come with installation

- instructions for the CPU, heatsink, and the retention mechanism. If the
instructions in this section do not match the CPU documentation, follow the
latter.

ASUS M2N32-SLI Premium Vista Edition
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2.  Attach one end of the retention bracket
to the retention module base.

3. Align the other end of the retention
bracket (near the retention bracket
lock) to the retention module base.
A clicking sound denotes that the
retention bracket is in place.

k Make sure that the fan and

heatsink assembly perfectly fits
the retention mechanism module
base, otherwise you cannot snap
the retention bracket in place.

4.  Push down the retention bracket lock
on the retention mechanism to secure
the heatsink and fan to the module
base.
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5. When the fan and heatsink assembly is in place, connect the CPU fan cable
to the connector on the motherboard labeled CPU_FAN.

M2N32-SLI PREMIUM
CPU Fan connectors

CPU_FAN

CPU FAN PWM
CPU FAN IN
CPU FAN PWR
GND

R + Do not forget to connect the CPU fan connector! Hardware monitoring
errors can occur if you fail to plug this connector.

+  This connector is backward compatiable with old 3-pin CPU fan.
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23.3

Installing the optional fan

Install the optional fan only if you are using a passive cooler or a water cooler.
Installing the optional fan with an active CPU cooler will interfere with the airflow
and destabilize the system.

1. Position the fan above the pipe 2. Fitthe grooved edge to the
and heatsink assembly. heatsink.

3. Carefully push down the fan until 4.  The above photo shows the fan
it snugly fits the heatsink, then installed on the motherboard.
connect the fan cables.

AN

»  Plug the optional fan cable to any of the CHA FAN1~4 connectors on the

motherboard.

»  Make sure the optional fan is installed correctly to prevent damage to the

fan and motherboard components.
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2.4 System memory

241 Overview

The motherboard comes with four Double Data Rate 2 (DDR2) Dual Inline Memory
Modules (DIMM) sockets.

A DDR2 module has the same physical dimensions as a DDR DIMM but has a
240-pin footprint compared to the 184-pin DDR DIMM. DDR2 DIMMs are notched
differently to prevent installation on a DDR DIMM socket.

The figure illustrates the location of the DDR2 DIMM sockets:

TEssssssTEs  DIMM_B2
— DM\ A2 (012CK)
_E— == r" DIMM_B1 (yellow)
E— = DIMM_A1

M2N32-SLI PREMIUM
240-pin DDR2 DIMM Sockets

Channel Sockets

Channel A DIMM_A1 and DIMM_A2
Channel B DIMM_B1 and DIMM_B2

24.2 Memory configurations

You may install 256 MB, 512 MB, 1 GB, and 2GB unbuffered ECC/non-ECC DDR2
DIMMs into the DIMM sockets.

Recommended Memory Configurations

Sockets

- | Populated | | -
Single-Channel
Populated | - | | -
Dual-channel (1) Populated | Populated | | -
Dual-channel (2) Populated | Populated | Populated | Populated

ASUS M2N32-SLI Premium Vista Edition 2-13



+ When using only one memory module, start installing the DDR2 DIMMs
from slot DIMM_A1 or DIMM_B1 for better overclocking capability.
+  For dual-channel configuration (2), you may:
+ install identical DIMMs in all four sockets OR
+ install identical DIMM pair in DIMM_A1 and DIMM_BH1 (yellow sockets)
and another identical DIMM pair in DIMM_A2 and DIMM_B2 (black
sockets)

Always use identical DDR2 DIMM pairs for dual channel mode. For
optimum compatibility, it is recommended that you obtain memory modules
from the same vendor. Visit the ASUS website (www.asus.com) for the
latest Qualified Vendors list.

Important notice on installing Windows® XP 32-bit version

If you install Windows® XP 32-bit version Operating System (OS), the limitation
of this OS version is that it may reserve a certain amount of memory space for
system devices. We recommend that you install less than 3 GB system memory
if you would like to work under Windows® XP 32-bit version OS. The excess
memory installation will not cause any usage problem, but it will not give users
the benefit of manipulating this excess memory space.

Visit the ASUS FAQ site for further <\_'3

explanation: = e
http://support.asus.com/fag/faq. [lan
aspx?SLanguage=en-us

Under General Search, make the
selections as shown, then click Search. Click the article titled “4GB memory
installed but less memory size detected.”

You also may check the URLs below for third party comments on this issue:
http:/disvr01.asus.com/pub/ASUS/mb/4AGB_Rev1.pdf
http://www.intel.com/support/motherboards/server/sb/cs-016594.htm

This motherboard can support 8 GB physical memory on the operating systems
listed below. You may install a maximum of 2 GB DIMMs on each slot.

32-bit 64-bit

Windows® 2000 Advanced Server Windows® Server 2003 Standard x64

Editi

Windows® Server 2003 Enterprise dition

Edition Windows® XP Professional x64
Edition

Windows® Server 2003 Enterprise
x64 Edition

Windows® Vista x64 Edition
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24.3 Installing a DIMM

y ' \ Unplug the power supply before adding or removing DIMMs or other
LR system components. Failure to do so can cause severe damage to both the
motherboard and the components.

To install a DIMM: 0
§ DDR2 DIMM notch
1. Unlock a DIMM socket by 0 l'
pressing the retaining clips

outward.

2. Align a DIMM on the socket
such that the notch on the DIMM =
matches the break on the socket.

3. Firmly insert the DIMM into the
socket until the retaining clips
snap back in place and the
DIMM is properly seated.

Unlocked retaining clip

k + ADDR2 DIMM is keyed with a notch so that it fits in only one direction. Do
not force a DIMM into a socket to avoid damaging the DIMM.

The DDR2 DIMM sockets do not support DDR DIMMs. DO not install DDR
DIMMs to the DDR2 DIMM sockets.

24.4 Removing a DIMM

To remove a DIMM:

1. Simultaneously press the retaining
clips outward to unlock the DIMM.

% Support the DIMM lightly with
- your fingers when pressing the
retaining clips. The DIMM might o

get damaged when it flips out
with extra force.

DDR2 DIMM notch

2. Remove the DIMM from the socket.

ASUS M2N32-SLI Premium Vista Edition
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M2N32-SLI Premium Vista Edition Motherboard
Qualified Vendors Lists (QVL)

DDR2-800 MHz capability

512MB
512MB
1024MB
1024MB
1024MB
256MB
256MB
512MB
512MB
512MB
512MB
1024MB
512MB
1024MB
512MB
1024MB
512MB
1024MB
512MB
1024MB
1024MB
256MB
256MB
512MB
512MB
512MB
512MB
256MB
512MB
512MB
512MB
1024MB
512MB
1024MB
512MB
1024MB
512MB
1024MB
512MB
512MB

Vendor

KINGSTON
KINGSTON
KINGSTON
KINGSTON
KINGSTON
SAMSUNG
SAMSUNG
SAMSUNG
Infineon
Infineon
Hynix
Hynix
MICRON
MICRON
MICRON
MICRON
MICRON
MICRON
CORSAIR
CORSAIR
CORSAIR
A-DATA
A-DATA
A-DATA
A-DATA
A-DATA
Apacer
TwinMOS
Elixir
NANYA
NANYA
NANYA
Crucial
Crucial
Crucial
Crucial
ocz

ocz

GEIL

GEIL

DIMM support
Chip No.

A* B*
Het-Sink Package SS KHX6400D2/512 . .
K4T51083QC SS KVR800D2N5/512
K4T51083QC DS KVR800D2N5/1G . . .
Heat-Sink Package DS KHX6400D2LL/1G . . .
Heat-Sink Package Ss KHX6400D2LLK2/1GN
K4T56083QF-ZCE7 Ss M378T3253FZ3-CE7 . . .
K4T56083QF-ZCE7(ECC) SS M391T3253FZ3-CE7 . . .
EDD339XX SS M378T6553CZ0-CE7
HYB18T256800AF25 DS HYS64T64520HU-2.5-A . . .
HYB18T256800AF25F DS HYS64T64020HU-25F-A . . .
HY5PS12821AFP-S6 SS HYMP564U64AP8-S6
HY5PS12821AFP-S6 DS HYMP512U64AP8-S6 . . .
5JAIIZ9DQQ SS MT8HTF6464AY-80EA3 . . .
5JAIIZ9DQQ DS MT16HTF12864AY-80EA3
5ZD22D9IGKX Ss MT8HTF6464AY-80ED4 . . .
5ZD22DIGKX DS MT16HTF12864AY-80ED4 . . .
6CD22D9GKX SS MT8HTF6464AY-80ED4
6CD22D9GKX DS MT16HTF12864AY-80ED4 . . .
Heat-Sink Package SS CM2X512A-6400 . . .
Heat-Sink Package Ds CM2X1024-6400PRO
Heat-Sink Package DS CM2X1024-6400C4 . . .
E2508AB-GE-E SS M20EL6F3G3160A1D0Z . . .
E2508AB-GE-E SS M20EL6F3G3170A1D0Z
E2508AB-GE-E DS M20EL6F3H4170A1D0Z . . .
N/A SS M20AD6G3H3160J1E52 . . .
AD29608A8A-25EG SS M20AD6G3H316011ESE
E2508AB-GE-E DS 78.91091.420 . .
E2508AB-GE-E SS 8G-24IK2-EBT . . .
N2TU51280AE-25C SS M2Y51264TU8BA2B-25C
NT5TU64MBAE-25C Ss NT512T64U88A1BY-25C . . .
NT5TU64M8BE-25C SS NT512T64U88B0OBY-25C . . .
NT5TU64M8BE-25C DS NT1GT64U8HBOBY-25C
Heat-Sink Package S8 BL6464AAB04.8FA . . .
Heat-Sink Package DS BL12864AA804.16FA . . .
Heat-Sink Package Ss BL6464AA804.8FD
Heat-Sink Package DS BL12864AA804.16FD . . .
Heat-Sink Package SS 0CZ28001024EBDCPE-K . . .
Heat-Sink Package 0CZ2G8002GK
Heat-Sink Package Ss GX21GB6400DC . . .
Heat-Sink Package SS GX21GB6400UDC . . .
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DDR2-667 MHz capability

512MB
512MB
512MB
512MB
1024MB
256MB
512MB
512MB
256MB
512MB
256MB
512MB
512MB
512MB
1024MB
1024MB
256MB
256MB
512MB
512MB
1024MB
512MB
1024MB
512MB
1024MB
256MB
512MB
512MB
512MB
512MB
512MB
256MB
512MB
1024MB
512MB
1024MB
512MB
1GB
512MB
512MB
512MB
1024MB
512MB
1024MB
512MB
1024MB
512MB
512MB
1024MB
1024MB

DIMM support
Vendor Chip No. ¥ @&
ADATA E5108AE-6E-E SS M20EL5G3H3160B1C0Z . .
ADATA AD29608A88-3EG SS M20AD5Q3H3163J1C52 . . .
AENEON AET93F30DA SS AET660UD00-30DA98Z
ELIXIR N2TU51280AF-3C SS M2U51264TU8BAOF-3C . .
ELIXIR N2TU51280AF-3C DS M2U1G64TUBHA2F-3C . . .
GEIL GL2L32M168BA30F SS GX25125300DC -
GEIL GL2L64G088BA30T SS GX21GB5300DC . . .
GEIL Heat-Sink Package SS GX21GB5300SDC . . .
HYNIX HY5PS121621AFP-Y5 SS HYMP532U64AP6-Y5 AA -
HYNIX HY5PS12821AFP-Y4 DS HYMP564U64AP8-Y4 AA . . .
HYNIX HY5PS12821AFP-Y5 SS HYMP532U64AP6-Y5 AA .
HYNIX HY5PS121621AFP-Y5 SS HYMP564UB4AP6-Y5 AA .
HYNIX HY5PS12821AFP-Y4 SS HYMP564U64AP8-Y4 AA . .
HYNIX HY5PS12821AFP-Y5 SS HYMP564U64AP8-Y5 AA . . .
HYNIX HY5PS12821AFP-Y4 DS HYMP512U64AP8-Y4 AB
HYNIX HY5PS12821AFP-Y5 DS HYMP512U64AP8-Y5 AB . . .
INFINEON HYB18T512160AF-3S SS HYS64T32000HU-3S-A .
INFINEON HYB18T512160BF-3S SS HYS64T32000HU-3S-B .
INFINEON HYB18T512800AF3S SS HYS64T64000HU-3S-A . .
INFINEON HYB18T512800BF3S SS HYS64T64000HU-3S-B . . .
INFINEON HYB18T512800BF3S SS HYS64T128020HU-3S-B .
KINGBOX E544H8GOWPAK SS N/A . .
KINGBOX E544H8GOWP91 DS N/A . .
KINGSTON E5108AE-6E-E SS KVR667D2N5/512 .
KINGSTON E5108AE-6E-E DS KVR667D2N5/1G . . .
KINGSTON HYB18T256800AF3 SS KVR667D2N5/256 . . .
KINGMAX KKEABBE4AAK-37 SS KLBC28F-ABKE4
MICRON 4VB41D9CZM DS MT16HTF6464AY-66784 . . .
MICRON 4VB41D9CZM DS MT16HTF6464AY-667B4 . .
NANYA NT5TUB4MBAE-3C SS NT512T64U88AQBY-3C .
NANYA NT5TU64M88E-3B SS NT512T64U88BOBY-3C . . .
NANYA NT5TU32M16AG-3C SS NT256T64UH4AOFY-3C . .
NANYA NT5TU64M8BE-3B SS NT512T64U88B0BY-3C .
PQl E5108AE-5C-E DS 0104-05A1 .
SAMSUNG K4T51083QC SS M378T6553CZ0-CE6 .
SAMSUNG K4T51083QC DS M378T2953CZ0-CE6 .
SAMSUNG K4T51083QC S8 M378T6553CZ0-CE6 . .
SAMSUNG K4T51083QC DS M378T2953CZ0-CE6 .
SAMSUNG K4T56083QF-ZCE6 DS M378T6453FZ0-CE6 .
TRANSCEND E5108AE-6E-E S8 TS64MLQ64V6J . .
CRUCIAL Heat-Sink Package DS BL6464AA664.16FB .
CRUCIAL Heat-Sink Package DS BL12864AA663.16FA .
CRUCIAL Heat-Sink Package DS CM64M6416U26AD2F-3VXADJFI-AW  « .
CRUCIAL Heat-Sink Package DS CM128M6416U27AD2F-3VXCDHZZ . .
ELPIDA E5108AE-6E-E SS EBEB1UDSAEFA-6E-E .
WINTEC 4WAIIDICWX DS 39137282 . . .
WINTEC 4UA12D9CRZ SS 39127282W24965R .
MDT 18D51280D-3 SS M512-667-8 .
MDT 18D51280D-3 DS M924-667-16 . .
0ocz Heat-Sink Package 0CZ26672048EBDCPE-K . .
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DDR2-533 MHz capability

DIMM support
Vendor Chip No.

512MB Hynix HY5PS12821F-C4 SS HYMP564U648-C4
1GB Hynix HY5PS12821F-C4 Ds HYMP512U728-C4 AA . .
512MB Hynix HY5PS12821AFP-C3 SS HYMP564U64AP8-C3 . .
1024MB Hynix HY5PS12821AFP-C3 DS HYMP512U64AP8-C3
512MB INFINEON HYB18T512 SS HYS64T64000GU-3.7-A . .
512MB INFINEON HYB18T512 SS HYS64T64000HU-3.7-A . .
512MB MICRON 4EB11D9BQM DS MT16HTF6464AG-53EB2
256MB SAMSUNG K4T56083QF-GCD5 SS M378T3253FG0-CD5 . . .
512MB SAMSUNG K4T151083QB-GCD5 SS M378T6553BG0-CD5 . .
1GB SAMSUNG K4T51083QB-GCD5 DS M391T2953BG0-CD5
512MB SAMSUNG K4T51083QB-GCD5 SS M391T6553BG0-CD5 .
512MB ELPIDA E5108AB-5C-E SS EBE51ED8ABFA-5C-E . .
512MB ELPIDA E5108AB-5C-E SS EBE51UD8ABFA-5C-E
256MB CENTURY K4T56083QF-GCD5 SS 25V6S8SSD5F4-K43 . .
512MB CENTURY E5108AB-5C-E SS 25V2HBEL5CB4-J43 . . .
512MB Aeneon AET93F370AG0513 SS AET660UDO00-370A98X
256MB Aeneon AET94F370A SS AET560UD00-370A98Z . . .
256MB Aeneon AET94F370A SS AET560UD00-370A98X . . .
512MB Aeneon AET93F370 SS AET660UDO00-370A98X
1024MB Aeneon AET93F370A DS AET760UD00-370A98X . . .
512MB Aeneon AET82F370A DS AET660UD00-370A88S . .
1024MB Aeneon AET93F370A DS AET760UD00-370A98Z
512MB Aeneon AET82F370A DS AET660UDO00-370A88S . .
512MB Veritech VTD264M8PC6G SS GTP512HLTM46DG . .
256MB KINGSTON E5116AF-5C-E SS KVR533D2N4/256
512MB KINGSTON HYB18T512800AF37 SS KVR533D2N4/512 . . .
1024MB KINGSTON 5YDIIDIGCT DS KVR533D2N4/1G . . .
512MB Qimonda HYB18T512800AC37 SS HYS64T64000GU-3.7-A
256MB Qimonda HYB18T512160AF-3.7 SS HYS64T32000HU-3.7-A . . .
512MB Qimonda HYB18T512800AF37 SS HYS64T64000HU-3.7-A . . .
1024MB Qimonda HYB18T512800AF37 DS HYS64T128020HU-3.7-A
256MB Qimonda HYB18T5121608BF-3.7 SS HYS64T32000HU-3.7-B . .

R + A*: Supports one module inserted in any slot as Single-channel memory
configuration.

+  B*: Supports one pair of modules inserted into either the yellow slots or the
black slots as one pair of Dual-channel memory configuration.

+  C*: Supports 4 modules inserted into both the yellow and black slots as two
pairs of Dual-channel memory configuration.

R Visit the ASUS website for the latest DDR2-800/667/533 MHz QVL.
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2.5 Expansion slots

In the future, you may need to install expansion cards. The following sub-sections
describe the slots and the expansion cards that they support.

E Make sure to unplug the power cord before adding or removing expansion
( cards. Failure to do so may cause you physical injury and damage motherboard
components.

2.5.1 Installing an expansion card

To install an expansion card:

1. Before installing the expansion card, read the documentation that came with
it and make the necessary hardware settings for the card.

2. Remove the system unit cover (if your motherboard is already installed in a
chassis).

3. Remove the bracket opposite the slot that you intend to use. Keep the screw
for later use.

4. Align the card connector with the slot and press firmly until the card is
completely seated on the slot.

5. Secure the card to the chassis with the screw you removed earlier.
Replace the system cover.

25.2  Configuring an expansion card

After installing the expansion card, configure the it by adjusting the software
settings.

1. Turn on the system and change the necessary BIOS settings, if any. See
Chapter 4 for information on BIOS setup.

2. Assign an IRQ to the card. Refer to the tables on the next page.
3. Install the software drivers for the expansion card.

R When using PCI cards on shared slots, ensure that the drivers support “Share
IRQ” or that the cards do not need IRQ assignments; otherwise, conflicts will
arise between the two PCI groups, making the system unstable and the card
inoperable.

ASUS M2N32-SLI Premium Vista Edition
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253 Interrupt assignments

Standard interrupt assignments

|3{e] Priority  Standard function

0 N oo o~ = O

©

10
11
12
13

14

System Timer

Keyboard Controller

Redirect to IRQ#9
Communications Port (COM1)*
IRQ Holder for PCI Steering*
Floppy Disk Controller

Printer Port (LPT1)*

System CMOS/Real Time Clock
IRQ Holder for PCI Steering*
IRQ Holder for PCI Steering*
IRQ Holder for PCI Steering*
PS/2 Compatible Mouse Port*
Numeric Data Processor

Primary IDE Channel

* These IRQs are usually available for ISA or PCI devices.

IRQ assignments for this motherboard

PCl slot 1

PCl slot 2
Onboard 1394
PCIE x16_1
PCIE x16_2
PCIEx 4

PCIE x 1

A B C D 3 F G H
- shared - - - - - -
- - shared - - - - -
shared - - - - - - -
shared - - - — - - -
- - - - — shared - -
- - - - - - shared -
— — — —  shared - — —
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2.5.4 PCl slots

The PClI slots support cards such as a LAN card, SCSI card, USB card, and other
cards that comply with PCI specifications. Refer to the figure below for the location
of the slots.

25.5  PCIl Express x4 slot & PCI Express x1 slot

This motherboard supports PCI Express x4 and PCI Express x1 network cards,
SCSiI cards and other cards that comply with the PCI Express specifications. Refer
to the figure below for the location of the slot.

2.5.6 PCI Express x16 slots

This motherboard supports two NVIDIA® SLI™-ready PCI Express x16 graphic
cards that comply with PCI Express specifications. Refer to the figure below for the
location of the slots.

PCI Express x16_1 slot (blue) PClI slot
PCI Express x4 slot PCl slot
PCI Express x1 slot  PCI Express x16_2 slot (black)

R +  Connect a rear chassis fan to the chassis (CHA_FAN1 or CHA_FAN2)
connector when using two graphics cards for better thermal environment.
See page 2-30 for details.

+ Insingle card mode, you may use either the blue or black slot for PCI
Express x16 cards.

In NVIDIA® SLI" mode, the PCI Express x16 slots work at the full bandwidth
of PCI Express x16 for a combined bandwidth of x32.

+ We recommend that you provide sufficient power when running NVIDIA®
SLI™ mode. See page 2-31 and 2-32 for details.

See chapter 6 for details on the NVIDIA SLI™ technology feature.
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2.6 Jumper

Clear RTC RAM (3-pin CLRTC)

This jumper allows you to clear the Real Time Clock (RTC) RAM in
CMOS. You can clear the CMOS memory of date, time, and system setup
parameters by erasing the CMOS RTC RAM data. The onboard button
cell battery powers the RAM data in CMOS, which include system setup
information such as system passwords.

To erase the RTC RAM:
1. Turn OFF the computer and unplug the power cord.

2. Remove the onboard battery.

3. Move the jumper cap from pins 1-2 (default) to pins 2-3. Keep the cap on
pins 2-3 for about 5~10 seconds, then move the cap back to pins 1-2.

4. Reinstall the battery.
5. Plug the power cord and turn ON the computer.

6. Hold down the <Del> key during the boot process and enter BIOS setup
to re-enter data.

Except when clearing the RTC RAM, never remove the cap on CLRTC jumper
default position. Removing the cap will cause system boot failure!

o)

— CLRTC
]

12 23

Normal  Clear CMOS
(Default)

M2N32-SLI PREMIUM
Clear RTC RAM

R + Make sure to re-enter your previous BIOS settings after you clear the
CMOS.

You do not need to clear the RTC when the system hangs due to
overclocking. For system failure due to overclocking, use the C.P.R. (CPU
Parameter Recall) feature. Shut down and reboot the system so the BIOS
can automatically reset parameter settings to default values.
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2.7 Connectors

2.71 Rear panel connectors

ek

1. PS/2 mouse port (green). This port is for a PS/2 mouse.

2.  Serial (COM) port. This 9-pin COM1 port is for pointing devices and other
serial devices.

3. IEEE 1394a port. This 6-pin IEEE 1394a port provides high-speed
connectivity for audio/video devices, storage peripherals, PCs, or portable
devices.

4. LAN 1/2 (RJ-45) port. Supported by Marvell® 88E1116 Gigabit LAN
controller, this port allows Gigabit connection to a Local Area Network
(LAN) through a network hub. Refer to the table below for the LAN port LED
indications.

LAN port LED indications
ACT/LINK SPEED

Activity/Link Speed LED

LED LED
|
OFF | No link | OFF 10 Mbps connection - gy =
ORANGE | Linked | ORANGE | 100 Mbps connection ‘
BLINKING | Data activity | GREEN 1 Gbps connection LAN port

5. Center/Subwoofer port (orange). This port connects the center/subwoofer
speakers.

6. Rear Speaker Out port (black). This port connects the rear speakers in a
4-channel, 6-channel, or 8-channel audio configuration.

7.  Line In port (light blue). This port connects the tape, CD, DVD player, or
other audio sources.

8. Line Out port (lime). This port connects a headphone or a speaker. In
4-channel, 6-channel, and 8-channel configuration, the function of this port
becomes Front Speaker Out.
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9. Microphone port (pink). This port connects a microphone.

10. Side Speaker Out port (gray). This port connects the side speakers in an
8-channel audio configuration.

Refer to the audio configuration table below for the function of the audio ports in

2, 4, 6, or 8-channel configuration.

Audio 2, 4, 6, or 8-channel configuration

Headset

Port 4-channel 6-channel 8-channel
2-channel

Light Blue | Line In Line In Line In Line In

Lime Line Out Front Speaker Out | Front Speaker Out | Front Speaker Out
Pink Mic In Mic In Mic In Mic In

Orange - - Center/Subwoofer | Center/Subwoofer
Black - Rear Speaker Out | Rear Speaker Ou Rear Speaker Out
Gray — — — Side Speaker Out

11. USB 2.0 ports 1 and 2, 3 and 4. These 4-pin Universal Serial Bus (USB)
ports are available for connecting USB 2.0 devices.

% Connect the IR receiver ONLY to USB port 3 and 4, which support remote
~ control function. Plugging any other USB devices to these two ports will turn on
the computer.

12. External SATA port. This port connects to an external SATA box or a Serial
ATA port multiplier. This port supports a Serial ATA hard disk drive that you
can combine with an external Serial ATA 3.0 Gb/s device to configure a RAID
0, RAID 1, or JBOD set through the onboard Silicon Image® SATA RAID
controller.

% The external SATA port supports
~ external Serial ATA

3.0 Gb/s devices. Longer

cables support higher power
requirements to deliver signal up
to two meters away, and enables
improved hot-swap function.
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13.

14.

15.

Before creating a RAID set using Serial ATA hard disks, make sure that you
have connected the Serial ATA signal cable and installed Serial ATA hard
disk drives; otherwise, you cannot enter the Silicon Image RAID utility and
SATA BIOS setup during POST.

If you intend to create a RAID configuration using this connector, set the
Silicon 3132 Controller item in the BIOS to [RAID Mode]. See section 4.4.6
Onboard Device Configuration for details.

Use these ports and an external Serial ATA box connected to the external
SATA port, if you want to configure a RAID 0, 1 or JBOD set.

The Serial ATA port multiplier and external Serial ATA box are purchased
separately.

DO NOT insert a different connector to this port.

DO NOT unplug the external Serial ATA box when a RAID 0 or JBOD is
configured.

Optical S/PDIF Out port. This port connects an external audio output device
via an optical S/PDIF cable.

Coaxial S/PDIF Out port. This port connects an external audio output device
via a coaxial S/PDIF cable.

PS/2 keyboard port (purple). This port is for a PS/2 keyboard.

ASUS M2N32-SLI Premium Vista Edition
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2.7.2 Internal connectors

1.  Floppy disk drive connector (34-1 pin FLOPPY)

This connector is for the provided floppy disk drive (FDD) signal cable. Insert
one end of the cable to this connector, then connect the other end to the
signal connector at the back of the floppy disk drive.

% Pin 5 on the connector is removed to prevent incorrect cable connection when
using a FDD cable with a covered Pin 5.

] FLOPPY

85| NOTE:Orient the red markings on
| the floppy ribbon cable to PIN1
oo

M2N32-SLI PREMIUM
Floppy disk drive connector

2. IDE connector (40-1 pin PRI_IDE)
The onboard IDE connector is for the Ultra DMA 133/100/66 signal cable.
There are three connectors on each Ultra DMA 133/100/66 signal cable:
blue, black, and gray. Connect the blue connector to the motherboard’s IDE
connector, then select one of the following modes to configure your device.

Drive jumper setting Mode of Cable connector
device(s)
Single device Cable-Select or Master | — Black
Master Black
Cable-Select
) Slave Gray
Two devices
Master | Master Black or gray
Slave | Slave

+  Pin 20 on the IDE connector is removed to match the covered hole on the
Ultra DMA cable connector. This prevents incorrect insertion when you
connect the IDE cable.

Use the 80-conductor IDE cable for Ultra DMA 100/66 IDE devices.

R If any device jumper is set as “Cable-Select,” make sure all other device
jumpers have the same setting.
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M2N32-SLI PREMIUM

IDE connector

NVIDIA® nForce® 590 SLI Southbridge Serial ATA connectors
(7-pin SATA1 [red], SATA2 [red], SATA3 [red], SATA4 [red], SATAS5 [red],

SATAG [red])

These connectors are for the Serial ATA signal cables for Serial ATA 3.0
Gb/s hard disk and optical disk drives. The Serial ATA 3.0 Gb/s is backward

compatible with Serial ATA 1.5 Gb/s specification.

If you installed Serial ATA hard disk drives, you can create a RAID 0, RAID
1, RAID 0+1, RAID 5, or JBOD configuration through the onboard NVIDIA®

MediaShield™ controller.

The RAID function of these connectors is set to [Disabled] by default. If you
intend to create a Serial ATA RAID set using these connectors, enable the RAID
Enabled item in the SATA Configuration sub-menu in the BIOS. See section

4.4.6 Onboard Device Configuration for details.

SATA5  SATA6

i W

SATA3  SATA4

o W

M2N32-SLI PREMIUM
SATA connectors

SATA1  SATA2
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% Connect the right-angle side right angle side

of SATA signal cable to SATA
device. Or you may connect the
right-angle side of SATA cable to
the onboard SATA port to avoid
mechanical conflict with huge
graphics cards.

4. Silicon Image®Serial ATA RAID connector (7-pin SATA_RAID2)

This connector is for a Serial ATA signal cable. This connector supports
a Serial ATA hard disk drive that you can configure for RAID through the
onboard Serial ATA RAID controller.

% The Silicon 3132 Controller item in the BIOS is set to [SATA Mode] by default,
allowing you to enable the hot-plug function for the external device. Set to [RAID
Mode] to use the connectors to build a RAID set. See section 4.4.6 Onboard
Device Configuration for details.

SATA_RAID2

I

M2N32-SLI PREMIUM
SATA RAID connector

R Before creating a RAID set using Serial ATA hard disks, make sure that you
have connected the Serial ATA signal cables and installed Serial ATA hard disk
drives; otherwise, you cannot enter the Silicon Image® RAID utility and SATA
BIOS setup during POST.
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USB connectors (10-1 pin USB56, USB 78, USB910_ASAP)

These connectors are for USB 2.0 ports. Connect the USB module cable
to any of these connectors, then install the module to a slot opening at the
back of the system chassis. These USB connectors comply with USB 2.0
specification that supports up to 480 Mbps connection speed.

i

Ag+ESN
oLd_gsn
+0Ld asn
ano

ON

USB910_ASAP

-6d_asn “
+6d8SN
ano

AG+8SN

—

USB+5V

b
4
Py
@
S

GND
USB_P5+

M2N32-SLI PREMIUM
USB 2.0 connectors 22

AN

—

USB78 ;%éﬁ% USBS56 ;%:H-

g
zZz
o

USB+5V

&

g
o
@
B

USB_P6+

Never connect a 1394 cable to the USB connectors. Doing so will damage the
motherboard!

You can connect the USB cable to ASUS Q-Connector (USB, blue) first, and
then install the Q-Connector (USB) to the USB connector onboard.

6. IEEE 1394a port connector (10-1 pin IE1394_1)

This connector is for a IEEE 1394a port. Connect the IEEE 1394a module
cable to this connector, then install the module to a slot opening at the back

ASUS M2N32-SLI Premium Vista Edition

of the system chassis.
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IEEE 1394 connector
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Never connect a USB cable to the IEEE 1394a connector. Doing so will damage
the motherboard!

R You can connect the 1394 cable to ASUS Q-Connector (1394, red) first, and

7.

then install the Q-Connector (1394) to the 1394 connector onboard.

CPU, chassis, power, and chipset fan connectors

(4-pin CPU_FAN, 3-pin CHA_FAN{1, 3-pin CHA_FAN2, 3-pin CHA_FANS3,
3-pin CHA_FAN4, 3-pin PWR_FAN, 3-pin CHIP_FAN )

The fan connectors support cooling fans of 350 mA~2000 mA (24 W max.)
or a total of 1 A~7 A (84 W max.) at +12V. Connect the fan cables to the fan
connectors on the motherboard, making sure that the black wire of each
cable matches the ground pin of the connector.

Do not forget to connect the fan cables to the fan connectors. Insufficient air

— flow inside the system may damage the motherboard components. These are

not jumpers! Do not place jumper caps on the fan connectors!

CPU FAN cPuFAN PWM
- CPU FAN IN

CPU FAN PWR

GND

CHA_FAN1  CHA_FAN2

=

GND
+12v
Rotation
GND
+12v
Rotatior

HE
JiE

— PWR_FAN CHIP_FAN

GND GND
+12v +12V.
Rotation Rotation

: CHA_FAN3  CHA_FAN4

M2N32-SLI PREMIUM E E
CPU Fan connectors

% +  Only the CPU-FAN and CHA-FAN 1-4 connectors support the ASUS Q

FAN2 feature.

+ Ifyou install two VGA cards, we recommend that you plug the rear
chassis fan cable to the motherboard connector labled CHA_FAN1
or CHA_FANZ2 for better themal environment.
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8. Chassis intrusion connector (4-1 pin CHASSIS)

This connector is for a chassis-mounted intrusion detection sensor or switch.
Connect one end of the chassis intrusion sensor or switch cable to this

connector. The chassis intrusion sensor or switch sends a high-level signal to
this connector when a chassis component is removed or replaced. The signal

is then generated as a chassis intrusion event.

By default , the pin labeled “Chassis Signal” and “Ground” are shorted with
a jumper cap. Remove the jumper caps only when you intend to use the

chassis intrusion detection feature.

M2N32-SLI PREMIUM

Chassis Signal

5VSB_MB
GND

?

or— CHASSIS %[“

(Default)

Chassis intrusion connector

9.  ATX power connectors (24-pin EATXPWR, 4-pin ATX12V)

These connectors are for ATX power supply plugs. The power supply plugs
are designed to fit these connectors in only one orientation. Find the proper
orientation and push down firmly until the connectors completely fit.

M2N32-SLI PREMIUM
ATX power connector

ASUS M2N32-SLI Premium Vista Edition

EATXPWR
ATX12V

GND 12V DG 43 Volts Ground
+12 Volts +5 Volts
+12 Volts 45 Volts

45V Standby +5 Volts
Power OK -5 Volts

GND  +12VDC Ground Ground

45 Volts Ground

Ground Ground

45 Volts PSON#

Ground Ground

+3 Volts -12 Volts

+3 Volts +3 Volts
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For a fully configured system, we recommend that you use a power supply
unit (PSU) that complies with ATX 12 V Specification 2.0 (or later version)
and provides a minimum power of 600 W.

Do not forget to connect the 4-pin ATX +12 V power plug; otherwise, the
system will not boot.

Use of a PSU with a higher power output is recommended when
configuring a system with more power-consuming devices. The system
may become unstable or may not boot up if the power is inadequate.

The ATX 12 V Specification 2.0-compliant (500W) PSU has been tested
to support the motherboard power requirements with the following
configuration:

CPU: AMD FX-62

Memory 1024 MB DDR2-800 (x4)

Graphics card: PCI Express x16 NVIDIA 7900GTX

Serial ATA device: SATA hard disk drive (x2)

Optical drives: DVD-RW

If you want to use two EN7950GX2 graphics cards, visit the NVIDIA
website(www.nvidia.com) for the qualified PSU vendor list.

10. Front panel audio connector (10-1 pin AAFP)

This connector is for a chassis-mounted front panel audio /0 module that
supports either HD Audio or legacy AC 97 audio standard. Connect one end
of the front panel audio 1/0 module cable to this connector.

AAFP

HD-audio-compliant Legacy AC'97
pin definition compliant definition

PRESENCE#
SENSE1_RETUR
SENSE2_RETUR

GND

e
e

MIC2
NC

M2N32-SLI PREMIUM
Analog front panel connector

AN

PORT1 L
PORT1R
PORT2 R
SENSE_SEND
PORT1 L
MICPWR

Line out_R

Line out_L

We recommend that you connect a high-definition front panel audio
module to this connector to avail of the motherboard’s high-definition audio
capability.

By default, this connector is set to [AC’97]. If you want to connect a High
Definition front panel audio module to this connector, set the Front Panel
Support Type item in the BIOS setup to [HD Audio]. See section 4.4.6
Onboard Device Configuration for details.
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11. Optical drive audio connector (4-pin CD)
These connectors allow you to receive stereo audio input from sound sources
such as a CD-ROM, TV tuner, or MPEG card.

CD

Right Audio Channel | L
GND.

T

GND.
LeftAudio Channel —# |-

M2N32-SLI PREMIUM
Internal audio connector

12. Parallel port connector (26-1 pin LPT)
This connector is for a parallel port. Connect the parallel port module cable
to this connector, then install the module to a slot opening at the back of the

system chassis.

—> LPT

\_/
M2N32-SLI PREMIUM
Parallel port connector

sTB#

% The parallel port cable is purchased separately.
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13. Digital audio connector (4-1 pin SPDIF_OUT)

This connector is for an additional Sony/Philips Digital Interface (S/PDIF)
port(s). Connect the S/PDIF Out module cable to this connector, then install
the module to a slot opening at the back of the system chassis.

SPDIFOUT

45V
GND

»
o
S
=
o
c
5

M2N32-SLI PREMIUM
Digital audio connector

% The S/PDIF module is purchased separately.

14. TPM connector (20-1 pin TPM)

This connector supports a Trusted Platform Module (TPM) system, which can
securely store keys, digital certificates, passwords, and data. A TPM system
also helps enhance network security, protects digital identities, and ensures
platform integrity. See section “4.6.6 Security” for details.

FRET =

5

R R
2adididiss

o
—= e (R

N
M2N32-SLI PREMIUM
TPM connector

% The TPM module is purchased separately. Use the ASUS TPM module ONLY.
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System panel connector (20-8 pin PANEL)

This connector supports several chassis-mounted functions.

5 8 zed
=338

PLED
PLED

"

u +
sel

o

PWR

— PANEL

&
]

IDE_LED-

a H
E g
o s
e

* Requires an ATX power supply

N4
M2N32-SLI PREMIUM
System panel connsector

System power LED (2-pin PLED)

This 2-pin connector is for the system power LED. Connect the chassis
power LED cable to this connector. The system power LED lights up when
you turn on the system power, and blinks when the system is in sleep mode.

Hard disk drive activity LED (2-pin IDE_LED)

This 2-pin connector is for the HDD Activity LED. Connect the HDD Activity
LED cable to this connector. The IDE LED lights up or flashes when data is
read from or written to the HDD.

System warning speaker (4-pin SPEAKER)

This 4-pin connector is for the chassis-mounted system warning speaker. The
speaker allows you to hear system beeps and warnings.

ATX power button/soft-off button (2-pin PWRSR)

This connector is for the system power button. Pressing the power button
turns the system on or puts the system in sleep or soft-off mode depending
on the BIOS settings. Pressing the power switch for more than four seconds
while the system is ON turns the system OFF.

Reset button (2-pin RESET)

This 2-pin connector is for the chassis-mounted reset button for system
reboot without turning off the system power.

ASUS M2N32-SLI Premium Vista Edition
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ASUS Q-Connector (system panel)

You can use the ASUS Q-Connector to connect/disconnect chassis front panel
cables in a few steps. Refer to the instructions below to install the ASUS Q-

Connector.

1. Connect the front panel cables to the
ASUS Q-Connector.

Refer to the labels on the Q-Connector
to know the detailed pin definitions, then
match them to the respective front panel
cable labels.

2. Install the ASUS Q-Connector to the
system panel connector, making sure
the orientation matches the labels on the
motherboard.

3. The front panel functions are now enabled. T
The figure shows the Q-Connector properly (8 St

installed on the motherboard.

2-36
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This chapter describes the power up
sequence, the vocal POST messages,
and ways of shutting down the system.

Powering up



3.1
3.2

Starting up for the first time
Turning off the computer.........ccccvcrnicsnssssennns
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3.1 Starting up for the first time

1. After making all the connections, replace the system case cover.
2. Be sure that all switches are off.
3. Connect the power cord to the power connector at the back of the system

chassis.

4.  Connect the power cord to a power outlet that is equipped with a surge
protector.

5. Turn on the devices in the following order:
a. Monitor

b. External SCSI devices (starting with the last device on the chain)
c. System power

6.  After applying power, the system power LED on the system front panel case

lights up. For systems with ATX power supplies, the system LED lights up

when you press the ATX power button. If your monitor complies with “green”
standards or if it has a “power standby” feature, the monitor LED may light up

or switch between orange and green after the system LED turns on.

The system then runs the power-on self tests or POST. While the tests are
running, the BIOS beeps (see BIOS beep codes table below) or additional

messages appear on the screen. If you do not see anything within 30

seconds from the time you turned on the power, the system may have failed a
power-on test. Check the jumper settings and connections or call your retailer

for assistance.

7. At power on, hold down the <Delete> key to enter the BIOS Setup. Follow the

instructions in Chapter 4.
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3.2 Turning off the computer

3.2.1 Using the OS shut down function
If you are using Windows® 2000:

Click the Start button then click Shut Down.

2. Make sure that the Shut Down option button is selected, then click the OK
button to shut down the computer.

3. The power supply should turn off after Windows® shuts down.

If you are using Windows® XP:

1. Click the Start button then select Turn Off Computer.
2. Click the Turn Off button to shut down the computer.
3. The power supply should turn off after Windows® shuts down.

If you are using Windows® Vista:

1. Click the Start button then select ShutDown.
2. The power supply should turn off after Windows® shuts down.

3.2.2 Using the dual function power switch

While the system is ON, pressing the power switch for less than four seconds puts
the system to sleep mode or to soft-off mode, depending on the BIOS setting.
Pressing the power switch for more than four seconds lets the system enter the
soft-off mode regardless of the BIOS setting. Refer to section “4.5 Power Menu”
in Chapter 4 for details.

Chapter 3: Powering up



This chapter tells how to change

the system settings through the BIOS
Setup menus. Detailed descriptions
of the BIOS parameters are also
provided.

BIOS setup



4.1
4.2
4.3
4.4
4.5
4.6
4.7
4.8

Managing and updating your BIOS............cccevnenenenene .44
BIOS setup program ... .4-10
MaiN MENU ...t nns 4-14
Advanced MENU ... sasess 4-19
POWer MeNU.......ccciinrriisrnsssn s 4-33
Boot menu

Tools menu
EXit MENU ...t sse s snnnnnnans
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4.1 Managing and updating your BIOS

The following utilities allow you to manage and update the motherboard Basic
Input/Output System (BIOS) setup.

1. ASUS Update (Updates the BIOS in Windows® environment.)

2. ASUS EZ Flash 2 (Updates the BIOS in DOS using a floppy disk / USB flash
disk, or the motherboard support DVD.)

3. Award BIOS Flash Utility (Updates the BIOS using a bootable floppy disk /
USB flash disk or a CD ROM.)

4.  ASUS CrashFree BIOS 3 (Updates the BIOS using a bootable floppy disk /
USB flash disk or the motherboard support DVD when the BIOS file fails or
gets corrupted.)

Refer to the corresponding sections for details on these utilities.

R Save a copy of the original motherboard BIOS file to a bootable floppy disk in
case you need to restore the BIOS in the future. Copy the original motherboard
BIOS using the ASUS Update or Award BIOS Flash utilities.

4.1.1 ASUS Update utility

The ASUS Update is a utility that allows you to manage, save, and update the
motherboard BIOS in Windows® environment. The ASUS Update utility allows you
to:

Save the current BIOS file

Download the latest BIOS file from the Internet

Update the BIOS from an updated BIOS file

Update the BIOS directly from the Internet, and

View the BIOS version information.

This utility is available in the support DVD that comes with the motherboard
package.

% ASUS Update requires an Internet connection either through a network or an
Internet Service Provider (ISP).

Installing ASUS Update
To install ASUS Update:

1. Place the support DVD in the optical drive. The Drivers menu appears.

2. Click the Utilities tab, then click Install ASUS Update VX.XX.XX. See page
5-3 for the Ultilities screen menu.

3.  The ASUS Update utility is copied to your system.

ASUS M2N32-SLI Premium Vista Edition
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% Quit all Windows® applications before you update the BIOS using this utility.

Updating the BIOS through the Internet
To update the BIOS through the Internet:

1. Launch the ASUS Update utility from the Windows® desktop by clicking Start
> Programs > ASUS > ASUSUpdate > ASUSUpdate. The ASUS Update
main window appears.
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2. Select Update BIOS from the 3. Select the ASUS FTP site nearest
Internet option from the drop-down you to avoid network traffic, or
menu, then click Next. click Auto Select. Click Next.
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4.  From the FTP site, select the BIOS
version that you wish to download.
Click Next.

5. Follow the screen instructions to
complete the update process.

7

The ASUS Update utility is

the Internet. Always update the
utility to avail all its features.

capable of updating itself through

Updating the BIOS through a BIOS file

To update the BIOS through a BIOS file:

1. Launch the ASUS Update utility from the Windows® desktop by clicking Start
> Programs > ASUS > ASUSUpdate > ASUSUpdate. The ASUS Update

main window appears.

2. Select Update BIOS from a file
option from the drop-down menu,
then click Next.

3. Locate the BIOS file from the Open
window, then click Open.

4.  Follow the screen instructions to
complete the update process.

ASUS M2N32-SLI Premium Vista Edition
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4.1.2 Creating a bootable floppy disk

1.

Do either one of the following to create a bootable floppy disk.

DOS environment

a. Insert a 1.44MB floppy disk into the drive.
b. Atthe DOS prompt, type format A:/S then press <Enter>.

Windows® XP environment

a. Insert a 1.44 MB floppy disk to the floppy disk drive.

b. Click Start from the Windows® desktop, then select My Computer.
c. Select the 3 1/2 Floppy Drive icon.
d

Click File from the menu, then select Format. A Format 3 1/2 Floppy
Disk window appears.

e. Select Create an MS-DOS startup disk from the format options field,
then click Start.

Windows® 2000 environment

To create a set of boot disks for Windows® 2000:

a. Insert a formatted, high density 1.44 MB floppy disk into the drive.

b. Insert the Windows® 2000 CD to the optical drive.

c. Click Start, then select Run.

d. From the Open field, type
D:\bootdisk\makeboot a:

assuming that D: is your optical drive.

e. Press <Enter>, then follow screen instructions to continue.

Copy the original or the latest motherboard BIOS file to the bootable floppy
disk.
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41.3  ASUS EZ Flash 2 utility

The ASUS EZ Flash 2 feature allows you to update the BIOS without having to go
through the long process of booting from a floppy disk and using a DOS-based
utility. The EZ Flash 2 utility is built-in the BIOS chip so it is accessible by pressing
<Alt> + <F2> during the Power-On Self Tests (POST).

To update the BIOS using EZ Flash 2:

1. Visit the ASUS website (www.asus.com) to download the latest BIOS file for
the motherboard.

2. Save the BIOS file to a floppy disk or a USB flash disk, then restart the
system.
3. You can launch the EZ Flash 2 by two methods.

(1) Insert the floppy disk / USB flash disk that contains the BIOS file to the
floppy disk drive or the USB port.

Press <Alt> + <F2> during POST to display the following.

ASUSTek EZ Flash 2 BIOS ROM Utility B318
FLASH TYPE: Winbond W39V080A 8Mb LPC
Current ROM

Update ROM
BOARD: M2N32-SLI PREMIUM BOARD: Unknown
VER: 0107 VER: Unknown
DATE: 12/25/2006 DATE: Unknown

PATH: A:\

1

Note
[Enter] Select [S] save [ESC] Exit

[Tab] Switch [Up/Down/Home/End] Move

(2) Enter BIOS setup program. Go to the Tools menu to select EZ Flash2
and press <Enter> to enable it.

You can switch between drives by pressing <Tab> before the correct file
is found. Then press <Enter>.

4. When the correct BIOS file is found, EZ Flash 2 performs the BIOS update
process and automatically reboots the system when done.

Y, '\ +  This function can support devices such as USB flash disk, hard disk, or
Loy floppy disk with FAT 32/16/12 format only.

+ Do not shut down or reset the system while updating the BIOS to prevent
system boot failure!
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41.4 Updating the BIOS

The Basic Input/Output System (BIOS) can be updated using the AwardBIOS
Flash Utility. Follow these instructions to update the BIOS using this utility.

1. Download the latest BIOS file from the ASUS web site. Rename the file to
M2N32SLI.BIN and save it to a floppy disk, CD ROM or a USB flash disk in
FAT 16/12 format.

R Save only the updated BIOS file in the disk to avoid loading the wrong BIOS file.

2. Copy the AwardBIOS Flash Utility (awdflash.exe) from the Software folder
of the support DVD to the floppy disk, CD ROM or a USB flash disk with the
latest BIOS file.

3. Boot the system in DOS mode using the bootable floppy disk, CD ROM or a
USB flash disk you created earlier.

4. Under the DOS mode,
use <X:> (X stands for

the name of the disk For NF590-SLI-M2N32-SLI-PREMIUM DATE:03/30/2006
assignment) to switch to Flash Type - PMC Pm49FL004T LPC/FWH

the folder of floppy disk, — |I— ]
CD ROM or USB flash
disk you saved the BIOS
fileand AwardBIOS Flash
Utility.

5- At 1he prompt J[ype Please input File Name!
awdflash then press
<Enter>. The Award BIOS
Flash Utility screen appears.
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6.  Type the BIOS file name in
the File Name to Program
fleld’ then press <Enter>. For NF590-SLI-M2N32-SLI-PREMIUM DATE:03/30/2006

Flash Type - PMC Pm49FL0O04T LPC/FWH

File Name to Program: [EVREFIANIEY

Do You Want To Save Bios (Y/N)

7.  Press <N>when the utility prompts you to save the current BIOS file. The
following screen appears.

8.  The utility verifies the BIOS
file in the floppy disk, CD
ROM or a USB flash disk For NF590-SLI-M2N32-SLI-PREMIUM  DATE:03/30/2006
and STaI’tS f|aShIng the Flash Type - PMC Pm49FL004T LPC/FWH

BlOS f||e File Name to Program:

Programming Flash Memory - OFE00 OK

Iy —

. Write OK No Update Write Fail

Warning:

% Do not turn off or reset the system during the flashing process!

9. The utility displays a
Flashing Complete

message indicating that For NF590-SLI-M2N32-SLI-PREMIUM  DATE:03/30/2006
you have successfully Flash Type - PMC Pm49FLO04T LPC/FWH

flashed the BIOS file. File Name to Program: m
Remove the disk then Flashing Complete

Press <F1> to Continue

press <F1> to restart the

. Write OK No Update Write Fail

-1
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4.1.5 Saving the current BIOS file

You can use the AwardBIOS Flash Utility to save the current BIOS file. You can
load the current BIOS file when the BIOS file gets corrupted during the flashing

process.

R Make sure that the floppy disk, CD ROM or a USB flash disk has enough disk

space to save the file.

To save the current BIOS file using the AwardBIOS Flash Utility:

1. Follow steps 1 to 6 of the
previous section.

2. Press <Y>when the utility
prompts you to save the
current BIOS file. The
following screen appears.

3. Type afilename for the
current BIOS file in the
Save current BIOS as field,
then press <Enter>.

4. The utility saves the
current BIOS file to the
disk, then returns to the
BIOS flashing process.

For NF590-SLI-M2N32-SLI-PREMIUM DATE:03/30/2006
Flash Type - PMC Pm49FL004T LPC/FWH

File Name to Program: [[ihBFIEE.Y

For NF590-SLI-M2N32-SLI-PREMIUM DATE:03/30/2006
Flash Type - PMC Pm49FL004T LPC/FWH

File Name to Program: [UiRPIN-EEY

Checksum: 810DH

Save current BIOS as: [JNKNSEY

Please Wait!

For NF590-SLI-M2N32-SLI-PREMIUM DATE:03/30/2006
Flash Type - PMC Pm49FL004T LPC/FWH

File Name to Program: [UREINE.Y
Now Backup System BIOS to

File!

Please Wait!
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41.6  ASUS CrashFree BIOS 3 utility

The ASUS CrashFree BIOS 3 is an auto recovery tool that allows you to restore
the BIOS file when it fails or gets corrupted during the updating process. You can
update a corrupted BIOS file using the motherboard support DVD, the floppy disk,
or the USB flash disk that contains the updated BIOS file.

R Prepare the motherboard support DVD, the floppy disk or the USB flash disk
containing the updated motherboard BIOS before using this utility.

Recovering the BIOS from the support DVD
To recover the BIOS from the support DVD:

Turn on the system.
2. Insert the motherboard support DVD to the optical drive.

3. The utility displays the following message and automatically checks the DVD
for the BIOS file.

Award BootBlock BIOS v1.0
Copyright (c) 2000, Award Software, Inc.

BIOS ROM checksum error
Detecting IDE ATAPI device...

When found, the utility reads the BIOS file and starts flashing the corrupted
BIOS file.

Award BootBlock BIOS v1.0
Copyright (c) 2000, Award Software, Inc.

BIOS ROM checksum error
Detecting IDE ATAPI device...
Found CDROM, try to Boot from it... Pass

4. Restart the system after the utility completes the updating process.
Recovering the BIOS from the USB flash disk
To recover the BIOS from the USB flash disk:

1. Insert the USB flash disk that contains BIOS file to the USB port.
2. Turnon the system.

3. The utility will automatically checks the devices for the BIOS file When found,
the utility reads the BIOS file and starts flashing the corrupted BIOS file.

4. Restart the system after the utility completes the updating process.
Only the USB flash disk with FAT 32/16/12 format and single partition can

support ASUS CrashFree BIOS 3. The device size should be smaller than
8GB.

- D

DO NOT shut down or reset the system while updating the BIOS! Doing so
can cause system boot failure!
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4.2 BIOS setup program

This motherboard supports a programmable Low-Pin Count (LPC) chip that you
can update using the provided utility described in section “4.1 Managing and
updating your BIOS.”

Use the BIOS Setup program when you are installing a motherboard, reconfiguring
your system, or prompted to “Run Setup.” This section explains how to configure
your system using this utility.

Even if you are not prompted to use the Setup program, you can change the
configuration of your computer in the future. For example, you can enable the
security password feature or change the power management settings. This
requires you to reconfigure your system using the BIOS Setup program so that the
computer can recognize these changes and record them in the CMOS RAM of the
LPC chip.

The LPC chip on the motherboard stores the Setup utility. When you start up the
computer, the system provides you with the opportunity to run this program. Press
<Del> during the Power-On Self-Test (POST) to enter the Setup utility; otherwise,
POST continues with its test routines.

If you wish to enter Setup after POST, restart the system by pressing
<Ctri+Alt+Delete>, or by pressing the reset button on the system chassis. You can
also restart by turning the system off and then back on. Do this last option only if
the first two failed.

The Setup program is designed to make it as easy to use as possible. Being a
menu-driven program, it lets you scroll through the various sub-menus and make
your selections from the available options using the navigation keys.

R +  The default BIOS settings for this motherboard apply for most conditions
to ensure optimum performance. If the system becomes unstable after
changing any BIOS settings, load the default settings to ensure system
compatibility and stability. Select the Load Default Settings item under the
Exit Menu. See section 4.8 Exit Menu.

The BIOS setup screens shown in this section are for reference purposes
only, and may not exactly match what you see on your screen.

Visit the ASUS website (www.asus.com) to download the latest BIOS file for
this motherboard.
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4.2.1 BIOS menu screen

Menu items Menu bar Configuration fields General help

jUFSR. W Advanced Power Boot Tools Exit

System Time 15 : 30 : 36 Select Menu
System Date Thu, Apr 6 2006
| Lanquage | [English] Item Specific Helph
Legacy Diskette A: [1.44M, 3.5 in.] Change the internal
»  Primary IDE Master [None] B
» Primary IDE Slave [None]
> SATA 1 [None]
> SATA 2 [None]
> SATA 3 [None]
> SATA 4 [None]
P SATA 5 [None]
P SATA 6 [None]

HDD SMART Monitoring [Disabled]

Installed Memory 512MB

Usable MemoryI 511MB

T
Sub-menu items Legend bar

4.2.2 Menu bar

The menu bar on top of the screen has the following main items:

Main For changing the basic system configuration

Advanced For changing the advanced system settings

Power For changing the advanced power management (APM)
configuration

Boot For changing the system boot configuration

Tools For configuring options for special functions

Exit For selecting the exit options and loading default
settings

To select an item on the menu bar, press the right or left arrow key on the keyboard
until the desired item is highlighted.

% +  The BIOS setup screens shown in this chapter are for reference purposes
only, and may not exactly match what you see on your screen.

+  Visit the ASUS website (www.asus.com) to download the latest BIOS
information.
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4.2.3 Legend bar

At the bottom of the Setup screen is a legend bar. The keys in the legend bar allow
you to navigate through the various setup menus. The following table lists the keys
found in the legend bar with their corresponding functions.

Navigation Key Function

<F1> Displays the General Help screen

<F5> Loads setup default values

<Esc> Exits the BIOS setup or returns to the main menu from a
sub-menu

Left or Right arrow Selects the menu item to the left or right

Up or Down arrow Moves the highlight up or down between fields

Page Down or — (minus)  Scrolls backward through the values for the highlighted field

Page Up or + (plus) Scrolls forward through the values for the highlighted field
<Enter> Brings up a selection menu for the highlighted field
<F10> Saves changes and exit

4.2.4 Menu items

The highlighted item on the menu bar displays the specific items for that menu.
For example, selecting Main shows the Main menu items.

The other items (Advanced, Power, Boot, and Exit) on the menu bar have their
respective menu items.

4.2.5 Sub-menu items

A solid triangle before each item on any menu screen means that the item has a
sub-menu. To display the sub-menu, select the item and press <Enter>.

4.2.6 Configuration fields

These fields show the values for the menu items. If an item is user-configurable,
you can change the value of the field opposite the item. You cannot select an item
that is not user-configurable.

A configurable field is enclosed in brackets, and is highlighted when selected. To
change the value of a field, select it then press <Enter> to display a list of options.
Refer to “4.2.7 Pop-up window.”
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4.2.7 Pop-up window

Select a menu item then press <Enter> to display a pop-up window with the
configuration options for that item.

m Advanced Power Boot Tools Exit

System Time 15 : 30 : 36 Select Menu
System Date Thu, Apr 6 2006
Language [English] Item Specific Help;
Legacy Diskette A: ifies the capacity
. Legacy Diskette A: hysical size of
Primary IDE Mastld tte drive A.
» Primary IDE Slavgq Disabled [1
o g i 720K , 3.5 in.  ..... [1]
> SATA 2 At 88 R oo .
> SATA 3 oI Fo8 8o o000 (1
> SATA 4
> SATA 5
> SATA 6
HDD SMART Monitdx
Installed Memory 1| :Move ENTER:Accept ESC:Abort
Usable Memory
| |

Pop-up menu

4.2.8 General help

At the top right corner of the menu screen is a brief description of the selected
item.
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4.3 Main menu

When you enter the BIOS Setup program, the Main menu screen appears, giving
you an overview of the basic system information.

Refer to section 4.2.1 BIOS menu screen for information on the menu screen
items and how to navigate through them.

m Advanced Power Boot Tools Exit

System Time 15 : 30 : 36 Select Menu
System Date Thu, Apr 6 2006
Language [English] Item Specific Helph
Legacy Diskette A: [1.44M, 3.5 in.] Change the internal
» Primary IDE Master [None] G
» Primary IDE Slave [None]
> SATA 1 [None]
> SATA 2 [None]
» SATA 3 [None]
> SATA 4 [None]
P SATA 5 [None]
> SATA 6 [None]
HDD SMART Monitoring [Disabled]
Installed Memory 256MB
Usable Memory 255MB

4.31 System Time [xx:xx:xx]

Allows you to set the system time.

4.3.2 System Date [Day xx/xx/xxxx]

Allows you to set the system date.

4.3.3 Language [English]

Allows you to choose the BIOS language version from the options.
Configuration options: [English] [French] [Deutsch] [Chinese (Trad.)]
[Chinese (Simp.)] [Japanese]

43.4 Legacy Diskette A [1.44M, 3.5 in.]

Sets the type of floppy drive installed.
Configuration options: [Disabled] [720K , 3.5 in.] [1.44M, 3.5 in.]
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4.3.5 Primary IDE Master/Slave

While entering Setup, the BIOS automatically detects the presence of IDE devices.
There is a separate sub-menu for each IDE device. Select a device item then
press <Enter> to display the IDE device information.

Main
Primary IDE Master Select Menu

PIO Mode [Auto] Item Specific Helphh

UDMA Mode [Auto]
Set a PIO mode for IDE

Primary IDE Master [Auto] device. Mode0 through 4

Access Mode [Auto] for successive increase in
performance.

Capacity 0 GB

Cylinder 0

Head 0

Sector 0

Transfer Mode None

The BIOS automatically detects the values opposite the dimmed items
(Capacity, Cylinder, Head, Sector and Transfer Mode). These values are not
user-configurable. These items show N/A if no IDE device is installed in the
system.

P10 Mode [Auto]

Sets the PIO mode for the IDE device.
Configuration options: [Auto] [Mode 0] [Mode 1] [Mode 2] [Mode 3] [Mode 4]

UDMA Mode [Auto]

Disables or sets the UDMA mode. Configuration options: [Disable] [Auto]

Primary IDE Master/Slave [Auto]

Select [Auto] to automatically detect an IDE hard disk drive. If automatic detection
is successful, the BIOS automatically fills in the correct values for the remaining
fields on this sub-menu. If the hard disk was already formatted on a previous
system, the setup BIOS may detect incorrect parameters. Select [Manual] to
manually enter the IDE hard disk drive parameters. If no drive is installed select
[None]. Configuration options: [None] [Auto] [Manual]
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Access Mode [Auto]

The default [Auto] allows automatic detection of an IDE hard disk drive.
Select [CHS] for this item if you set the IDE Primary Master/Slave to [Manual].
Configuration options: [CHS] [LBA] [Large] [Auto]

' Before attempting to configure a hard disk drive, make sure you have the
° correct configuration information supplied by the drive manufacturer. Incorrect
settings may cause the system to fail to recognize the installed hard disk.

Capacity
Displays the auto-detected hard disk capacity. This item is not configurable.

Cylinder
Shows the number of the hard disk cylinders. This item is not configurable.

Head
Shows the number of the hard disk read/write heads. This item is not configurable.

Sector
Shows the number of sectors per track. This item is not configurable.

Transfer Mode
Shows the Transfer mode. This item is not configurable.

/ After entering the IDE hard disk drive information into BIOS, use a disk utility,

& such as FDISK, to partition and format new IDE hard disk drives. This is
necessary so that you can write or read data from the hard disk. Make sure to
set the partition of the Primary IDE hard disk drives to active.
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43.6  SATA1-6

While entering Setup, the BIOS automatically detects the presence of Serial ATA
devices. There is a separate sub-menu for each SATA device. Select a device item
then press <Enter> to display the SATA device information.

Main
SATA 1 Select Menu
Extended IDE Drive [Auto] Item Specific Helphh
Access Mode [Auto]

Selects the type of
Capacity 0 MB fixed disk connected
to the system.
Cylinder
Head
Landing Zone
Sector

ocococo

The BIOS automatically detects the values opposite the dimmed items

(Capacity, Cylinder, Head, Landing Zone and Sector). These values are not user-
configurable. These items show 0 if no SATA device is installed in the system.
Extended IDE Drive [Auto]

Selects the type of fixed disk connected to the system.

Configuration options: [None] [Auto]

Access Mode [Auto]
Sets the sector addressing mode. Configuration options: [Large] [Auto]

% Before attempting to configure a hard disk drive, make sure you have the
s correct configuration information supplied by the drive manufacturer. Incorrect
settings may cause the system to fail to recognize the installed hard disk.

Capacity
Displays the auto-detected hard disk capacity. This item is not configurable.

Cylinder
Shows the number of the hard disk cylinders. This item is not configurable.

ASUS M2N32-SLI Premium Vista Edition



4-18

Head
Shows the number of the hard disk read/write heads. This item is not configurable.

Landing Zone
Shows the number of landing zone per track. This item is not configurable.

Sector
Shows the number of sectors per track. This item is not configurable.

% After entering the IDE hard disk drive information into BIOS, use a disk utility,
such as FDISK, to partition and format new IDE hard disk drives. This is
necessary so that you can write or read data from the hard disk. Make sure to

set the partition of the Primary IDE hard disk drives to active.

4.3.7 HDD SMART Monitoring [Disabled]

Allows you to enable or disable the HDD Self-Monitoring Analysis and Reporting
Technology (SMART) feature. Configuration options: [Disabled] [Enabled]

4.3.8 Installed Memory [xxx MB]

Shows the size of installed memory.

4.3.9 Usable Memory [ XXX MB]

Shows the size of usable memory.
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4.4 Advanced menu

The Advanced menu items allow you to change the settings for the CPU and other
system devices.

/ '\ Take caution when changing the settings of the Advanced menu items. Incorrect
> field values can cause the system to malfunction.

Main WEGUCLEEGEN Power Boot  Tools Exit
»  JumperFree Configuration Select Menu
» AI Net2
Item Specific Helph
: gﬁ!;p(s::xéﬁguration Adjust system
>  BCIPAD frequency/voltage.
» Onboard Device Configuration

441 JumperFree Configuration

Advanced
JumperFree Configuration Select Menu
AI Tuning _ [Auto] Item Specific Helphh

x Overclock Options Disabled
x N.O.S. Option Disabled P E
x CPU Frequency Auto riss L nteri t:
x BCIE X16_1 Clock Auto s Greaeies
x PCIE X16_2 Clock Auto profile.
x DDR2 Voltage Control Auto
x CPU Voltage Auto
x CPU Multiplier Auto
» Advanced Voltage Control

Al Tuning [Auto]

Allows selection of CPU overclocking options to achieve desired CPU internal
frequency. Selct either one of the preset overclocking configuration options:

Manual Allows you to individually set overclocking parameters.

Auto Loads the optimal settings for the system.
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Standard Loads the standard settings for the system.

Al Overclock Loads overclocking profiles with optimal parameters for
stability when overclocking.
AIN.O.S. The ASUS Non-delay Overclocking System feature

intelligently determines the system load and automatically
boosts the performance for the most demanding tasks.

/ The following item becomes user-configurable when you set Al Tuning to
- [Al Overclock].

Overclock Options [Disabled]

Allows you to set the overclocking options.

Configuration options: [Disabled] [Overclock 3%)] [Overclock 5%] [Overclock 8%)]
[Overclock 10%)]

% The following item becomes user-configurable when you set Al Tuning to
e [AIN.O.S]

N.O.S. Option [Disabled]

Allows you to set the Non-delay Overclocking System mode.
Configuration options: [Disabled] [Overclock 3%] [Overclock 5%)] [Overclock 8%)]
[Overclock 10%)]

% The following items will become user-configurable when you set Al Tuning to
[Manual]

CPU Frequency [XXX] (value is auto-detected)

Indicates the frequency sent by the clock generator to the system bus and PCI
bus. The bus frequency (external frequency) multiplied by the bus multiple equals
the CPU speed. The BIOS auto-detects the value of this item. The values range
from 200.0 to 425.0.

' Setting a very high CPU frequency may cause the system to become unstable.
: If this happens, revert to the default setting.

PCIEX16_1 Clock [Auto]

Allows you to set the clock of the PCI Express_1.
Configuration options: [Auto] [100MHz]~[200MHZ]

PCIEX16_2 Clock [Auto]

Allows you to set the clock of the PCI Express_2.
Configuration options: [Auto] [100MHz]~[200MHZ]
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DDR2 Voltage Control [Auto]

Allows you to set the operating DDR2 voltage.
Configuration options: [Auto] [1.800V] [1.825V] [1.850V]~[2.500V]

CPU Voltage [Auto]

Allows you to set the operating CPU voltage. The configuration options may vary
depending on the type of CPU installed. Configuration options: [Auto] [1.5625V]
[1.5500V] [1.5375V] [1.5250V] [1.5125V] [1.5000V]~[0.8875V] [0.8750V] [0.8625V]
[0.8500V] [0.8375V] [0.8250V] [0.8125V] [0.8000V]

\ Please refer to CPU documentation before setting the CPU Vcore voltage.
® - Setting a high Vcore voltage may damage the CPU.

CPU Multiplier [Auto]

Allows you to set the operating CPU multiplier. The configuration options may vary
depending on the type of CPU installed.
Configuration options: [Auto] [5x] [6x]~[25X]

Advanced Voltage Control

_

Advanced Voltage Control Select Menu
CPU Vcore Offset Voltage [Disabled] Item Specific Helphhh
DDR2 Termination Voltage [0.5 x DDR2 Voltage]
CPU to NB HT Voltage [Auto] When select enabled in
NB to SB HT Voltage [Auto] this item, CPU Vcore
NB Core/PCI-E Voltage [Auto] voltage will offset
SB Core/PCI-E Voltage [Auto] 200mv.
SB Standby Core Voltage [+1.50V]

CPU Vcore Offset Voltage [Disabled]

Enables or disables the CPU Vcore offset voltage. When this item is set to
[Enabled], the CPU Vcore voltage will offset 200mV.

Configuration options: [Disabled] [Enabled]

DDR2 Termination Voltage [0.5 x DDR2 Voltage]
Allows you to set the DDR2 termination voltage.
Configuration options: [0.5 x DDR2 Voltage] [0.6 x DDR2 Voltage]

CPU to NB HT Voltage [Auto]
Allows you to set the CPU to Northbridge HT voltage.
Configuration options: [Auto] [1.200V] [1.225V] [1.250V]~[1.500V]
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NB to SB HT Voltage [Auto]

Allows you to set the NB to SB HT voltage.
Configuration options: [Auto] [+1.300V] [+1.325V] [+1.350V]~[+1.500V]

NB Core/PCI-E Voltage [Auto]

Allows you to set the NB Core/PCI-E voltage.
Configuration options: [Auto] [+1.200V] [+1.250V] [+1.300V] [+1.350V]

[+1.400V]

SB Core/PCI-E Voltage [Auto]

Allows you to set the Southbridge core/PCI Express voltage.
Configuration options: [Auto] [+1.500V] [+1.525V] [+1.550V]~[+1.700V]

[+1.750V]

SB Standby Core Voltage [+1.50V]

Allows you to set the Southbridge +1.5V standby voltage.

Configuration options: [+1.50V] [+1.60V] [+1.70V]

442  AINET2

AI Net2

Select Menu

POST Check LAN Cable
POST Check LAN2 Cable

Pair

LAN1 (1-2)
LAN1 (3-6)
LAN1 (4-5)
LAN1 (7-8)

LAN2 (1-2)
LAN2 (3-6)
LAN2 (4-5)
LAN2 (7-8)

[Disabled]
[Disabled]

Status

Open
Open
Open
Open

Open
Open
Open
Open

Length

N/A
N/A
N/A
N/A

N/A
N/A
N/A
N/A

Item Specific Helph»

Enable or Disable LAN
cable check during
POST.

POST Check LAN Cable [Disabled]
POST Check LAN2 Cable[Disabled]

Enables or disables checking of the LAN/LAN2 cable during the Power-On
Self-Test (POST). Configuration options: [Disabled] [Enabled]
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443 CPU Configuration

Advanced
CPU Configuration Select Menu
CPU Type AMD Sempron (tm) Processor 3000+ Item Specific Helph»
O Geed] 1600 MH DRAM timing and
pee z
Cache RAM 256K contzelt
> DRAM Configuration
AMD Live! [Disabled]
AMD Cool ‘'‘n’ Quiet Function [Disabled]
DRAM Configuration

The items in the sub-menu show the DRAM-related information auto-detected by
the BIOS.

Advanced
DRAM Configuration Select Menu
Memory Clock Frequency [Auto] Item Specific Helphhd
Tcl [Auto]
Trcd [Auto] Setting platform
R L) Memclock or limit
Tras [Auto]
1T/2T Memory Timing [Auto] value.
DRAM ECC Enable [Auto]
AI Clock Skew [Auto]
x channel A Clock Skew Advance 150ps
x channel B Clock Skew Advance 150ps
pAdvance Memeory Settings
pDRAM Timing Control
pOutput Driver Control
Current DRAM Timing 667MHz-5-5-5-13-2T

Memory Clock Frequency [Auto]

Sets the memory clock frequency.
Configuration options: [Auto] [DDR2 400] [DDR2 533] [DDR2 667]
[DDR2 800]

Tcl [Auto]
Configuration options: [Auto] [3] [4] [5] [6]

Tred [Auto]
Configuration options: [Auto] [3] [4] [5] [6]

Trp [Aut
Configuration options: [Auto] [3] [4] [5] [6]

Tras [Auto]
Configuration options: [Auto] [5] [6] [7]~[18]
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17727 Memory Timing [Auto]
Sets the memory timing. Configuration options: [Auto] [1T] [2T]

DRAM ECC Enable [Disabled]
Enables or disables the DRAM ECC function.
Configuration options: [Disabled] [Enabled]

/ This item appears only when you install DRAM modules that support ECC
- function.

Al Clock Skew [Auto]

Allows you to adjust the DRAM clock skew for Channel A and B. The
following two items become user-configurable when you set the Al Clock
Skew item to [Manual]. Configuration options: [Auto] [Manual]

Channel A Clock Skew [Normal]

[Advance 900ps] [Advance 750ps] [Advance 600ps] [Advance 450ps]
[Advance 300ps] [Advance 150ps] [Normal] [Delay 150ps] [Delay 300ps]
[Delay 450ps] [Delay 600ps] [Delay 750ps] [Delay 900ps]

Channel B Clock Skew [Normal]

[Advance 900ps] [Advance 750ps] [Advance 600ps] [Advance 450ps]
[Advance 300ps] [Advance 150ps] [Normal] [Delay 150ps] [Delay 300ps]
[Delay 450ps] [Delay 600ps] [Delay 750ps] [Delay 900ps]

Advance Memory Settings

CPU On-die Termination [Auto]
Configuration options: [Auto] [300ohm] [1500hm] [750hm]

Trc [Auto]
Configuration options: [Auto] [11] [12] [13]~[25] [26]

Twr [Auto]
Configuration options: [Auto] [3] [4] [5] [6]

Trrd [Auto]
Configuration options: [Auto] [2] [3] [4] [5]

Trwt [Auto]
Configuration options: [Auto] [2] [3] [4] [5] [6] [7] [8] [9]

Twir [Auto]
Configuration options: [Auto] [1] [2] [3]

Trtp [Auto]
Configuration options: [Auto] [2/4] [3/5]

Twrrd [Auto]
Configuration options: [Auto] [0] [1] [2] [3]

Twrwr [Auto]
Configuration options: [Auto] [1] [2] [3]
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Trdrd [Auto]
Configuration options: [Auto] [2] [3] [4] [5]

Tref [Auto]
Configuration options: [Auto] [7.8 us] [3.9 us]

Trfc [Auto]
Configuration options: [Auto] [0] [1] [2] [3]

DRAM Termination [Auto]
Configuration options: [Auto] [Disabled] [75 ohms] [150 ohms] [50 ohms]

Max Async Latency [Auto]
Configuration options: [Auto] [0 ns] [1 ns] [2 ns] [3 ns]~[14 ns] [15 ns]

R/W Queue Bypass [Auto]
Configuration options: [Auto] [2x] [4x] [8x] [16x]

Dynamic Idle Cycle Counter [Auto]
Configuration options: [Auto] [Disabled] [Enabled]

Idle Cycle Limit [Auto]
Configuration options: [Auto] [0 cycles] [4 cycles] [8 cycles] [16 cycles] [32 cycles]
[64 cycles] [128 cycles] [256 cycles]

DCQ Bypass Maximum [Auto]
Configuration options: [Auto] [0x] [1x] [2x] [3x]~[14x] [15X]

DRAM Burst Length [Auto]
Configuration options: [Auto] [64-byte] [32-byte]

RdPadRcvFIFO Delay [Auto]
Configuration options: [Auto] [1.5] [2] [2.5] [3] [3.5]

Disable Jitter [Auto]
Configuration options: [Auto] [OFF] [ON]

DRAM Bank Interleaving [Enabled]
Configuration options: [Disabled] [Enabled]

Bank Swizzle Mode [Enabled]
Configuration options: [Disabled] [Enabled]

DRAM Timing Control

CKE Fine Delay [Auto]

Configuration options: [Auto] [No delay] [1/64 MEMCLK delay] [2/64 MEMCLK
delay] [3/64 MEMCLK delay] [4/64 MEMCLK delay] [5/64 MEMCLK delay]~[30/64
MEMCLK delay] [31/64 MEMCLK delay]

CKE Setup Time [Auto]
Configuration options: [Auto] [1/2 MEMCLK] [1 MEMCLK]
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CS/ODT Fine Delay [Auto]

Configuration options: [Auto] [No delay] [1/64 MEMCLK delay] [2/64 MEMCLK
delay] [3/64 MEMCLK delay] [4/64 MEMCLK delay] [5/64 MEMCLK delay]~[30/64
MEMCLK delay] [31/64 MEMCLK delay]

CS/ODT Setup Time [Auto]
Configuration options: [Auto] [1/2 MEMCLK] [1 MEMCLK]

Address/Command Fine Delay [Auto]

Configuration options: [Auto] [No delay] [1/64 MEMCLK delay] [2/64 MEMCLK
delay] [3/64 MEMCLK delay] [4/64 MEMCLK delay] [5/64 MEMCLK delay]~[30/64
MEMCLK delay] [31/64 MEMCLK delay]

Address/Command Setup Time [Auto]
Configuration options: [Auto] [1/2 MEMCLK] [1 MEMCLK]

Read DQS Timing Control [Auto]

Configuration options: [Auto] [no delay] [1/96 MEMCLK delay] [2/96 MEMCLK
delay] [3/96 MEMCLK delay] [4/96 MEMCLK delay] [5/96 MEMCLK delay]~[46/96
MEMCLK delay] [47/96 MEMCLK delay]

Write Data Timing Control [Auto]

Configuration options: [Auto] [no delay] [1/96 MEMCLK delay] [2/96 MEMCLK
delay] [3/96 MEMCLK delay] [4/96 MEMCLK delay] [5/96 MEMCLK delay]~[46/96
MEMCLK delay] [47/96 MEMCLK delay]

DQS Receiver Enable Timing [Auto]
Configuration options: [Auto] [0 ps] [50 ps] [100 ps] [150 ps] [200 ps] [250 ps] [300
ps] [350 ps] [400 ps]~[8550 ps] [8600 ps] [8650 ps] [8700 ps]

Output Driver Control

CKE Drive Strength [Auto]
Configuration options: [Auto] [1.00x] [1.25x] [1.50x] [2.00x]

CS/ODT Drive Strength [Auto]
Configuration options: [Auto] [1.00x] [1.25x] [1.50x] [2.00x]

Add/CMD Drive Strength [Auto]
Configuration options: [Auto] [1.00x] [1.25x] [1.50x] [2.00x]

MEMCLK Drive Strength [Auto]
Configuration options: [Auto] [0.75x] [1.00x] [1.25x] [1.50x]

Data Drive Strength [Auto]
Configuration options: [Auto] [0.75x] [1.00x] [1.25x] [1.50x]

DQS Drive Strength [Auto]
Configuration options: [Auto] [0.75x] [1.00x] [1.25x] [1.50x]

DRAM Drivers Weak Mode [Auto]
Configuration options: [Auto] [Normal] [Weak]
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AMD Live! [Disabled]

Enables or disables the AMD Live! technology.
Configuration options: [Disabled] [Enabled]

AMD Cool ‘n’ Quiet Function [Disabled]

Enables or disables the AMD Cool ‘n’ Quiet technology.
Configuration options: [Auto] [Disabled]

444 Chipset

_

Chipset Select Menu
NB to SB HT Frequency [Auto] Item Specific Helphhp
CPU<->NB HT Speed [Auto]
NB-->SB HT Speed [5%NB to SB HT Frequency]
SB-->NB HT Speed [5%SB to NB HT Frequency]
CPU<->NB HT Width [/16 116]
NB<->SB HT Width [,16 116]
NVIDIA GPU Ex [Disabled]

NB to SB HT Frequency [Auto]

Allows you to set the Northbridge to Southbridge HT frequency.
Configuration options: [200.0]~{400.0]

CPU<->NB HT Speed [Auto]

Allows yout o set the CPU to Northbridge HT Speed.
Configuration options: [1XCPU Frequency] [2xCPU Frequency] [3xCPU Frequency]
[4xCPU Frequency] [5xCPU Frequency]

NB-->SB HT Speed [5xNB to SB HT Frequency]

Allows you to set the Northbridge to Southbridge HT Speed.

Configuration options: [1xNB to SB HT Frequency] [2xNB to SB HT Frequency]
[3xNB to SB HT Frequency] [4xNB to SB HT Frequency]

[5xNB to SB HT Frequency]
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SB-->NB HT Speed [5xSB to NB HT Frequency]

Allows you to set the Southbridge to Northbridge HT Speed.

Configuration options: [1xSB to NB HT Frequency] [2xSB to NB HT Frequency]
[3xSB to NB HT Frequency] [4xSB to NB HT Frequency]

[5xSB to NB HT Frequency]

CPU<->NB HT Width [|16 116]

Allows you to set the CPU to Northbridge HT width.
Configuration options: [|8 18] [| 16 116]

NB<->SB HT Width [| 16 116]

Allows you to set the Northbridge to Southbridge HT width.
Configuration options: [{4 14][|8 18] [} 16 116]

NVIDIA GPU Ex [Disabled]

Allows you to enable the optimized Nvidia® Ex graphics driver.
Configuration options: [Auto] [Disabled]
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4.4.5 PCIPnP

_

PCIPnP Select Menu
Plug & Play 0/S [No] Item Specific Helphh
Resources Controlled By [Auto] Select Yes if you are using

x IRQ Resources a Plug and Play capable

operating system. Select
No if you need the BIOS to
configure non-boot devices.

Plug & Play O/S [No]

When set to [No], the BIOS configures all the devices in the system. When set to
[Yes] and if you install a Plug and Play operating system, the operating system
configures the Plug and Play devices not required for boot.

Configuration options: [No] [Yes]

Resources Controlled By [Auto]

When set to [Auto], the BIOS automatically configures all the boot and Plug and
Play compatible devices. Set to [Manual] if you want to assign the IRQ DMA and
memory base address fields. Configuration options: [Auto] [Manual]

/ The item IRQ Resources becomes user-configurable when you set Resources
Controlled By to [Manual].

IRQ Resources

_

IRQ Resources Select Menu

Item Specific Helphhd

IRQ-5 assigned to [PCI Device] :

IRQ-7 assigned to [PCI Device] gzgai{aii}\wig gﬁzlzji feril
IRQ-9 assigned to [PCI Device] Pcmg'.l.‘ FEO O eciﬁcationg
IRQ-10 assigned to [PCI Device] PCI/ISA PnPPfor deviceé
IRQ-11 assigned to [PCI Device] compliant with the Plu
IRQ-14 assigned to [PCI Device] anlanPla el whetger
IRQ-15 assigned to [PCI Device] Y

designed for PCI or ISA
bus architecture.

IRQ-xx assigned to

When set to [PCI Device], the specific IRQ is free for use of PCI/PnP
devices. When set to [Reserved], the IRQ is reserved for legacy ISA devices.
Configuration options: [PCI Device] [Reserved]
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4.4.6 Onboard Device Configuration

Onboard Device Configuration Select Menu

» IDE Function Setup i
» Serial-ATA Configuration CtenSceciacielon
» USB Configuration

Onboard 1394 Controller [Enabled]

Onboard 1lst nVidia LAN [Enabled]

Onboard 2nd nVidia LAN [Enabled]

Onboard LAN Boot ROM [Disabled]

Primary Display Adapter [PCI-E slot]

HD Audio [Auto]

Front Panel Support Type [AC97]

Silicon SATAII Controller [SATA Mode]

ASUS ASAP [Disabled]

Serial Portl Address [3F8/IRQ4]

Parallel Port Address [378/IRQ7]

Parallel Port Mode [EPP]
x ECP Mode Use DMA [3]

IDE Function Setup

This sub-menu contains IDE function-related items. Select an item then press
<Enter> to edit.

_

IDE Function Setup Select Menu
OnChip IDE Channel0 [Enabled] Item Specific Helphh»
IDE DMA transfer access [Enabled]
IDE Prefetch Mode [Enabled]

OnChip IDE Channel0 [Enabled]
Allows you to enable or disable the onchip IDE channel 0 controller.
Configuration options: [Disabled] [Enabled]

IDE DMA transfer access [Enabled]
Allows you to enable or disable the IDE DMA transfer access.
Configuration options: [Disabled] [Enabled]

IDE Prefetch Mode [Enabled]
Allows you to enable or disable the IDE PIO read prefetch mode.
Configuration options: [Disabled] [Enabled]
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Serial-ATA Configuration

This sub-menu allows you to change Serial ATA settings. Select an item then press
<Enter> to edit.

_

Serial-ATA Configuration Select Menu

Serial-ATA Controller [Enabled] Item Specific HelphhP
RAID Enabled [Disabled]

x SATA 1 RAID Disabled Press [Enter] to

x SATA 2 RAID Disabled control onchip SATA

x SATA 3 RAID Disabled controller

x SATA 4 RAID Disabled

x SATA 5 RAID Disabled

X SATA 6 RAID Disabled

Serial-ATA Controller [Enabled]
Configuration options: [Disabled] [Enabled]

RAID Enabled [Disabled]

Enables or disables the onboard RAID controller. When set to [Enabled], the
succeeding items become user-configurable.

Configuration options: [Disabled] [Enabled]

SATA1~6_RAID [Disabled]
Enables or disables the RAID function of the SATA 1~6 drive.
Configuration options: [Disabled] [Enabled]

USB Configuration

The items in this menu allows you to change the USB-related features. Select an
item then press <Enter> to display the configuration options.

_

USB Configuration Select Menu
USB Controller [Enabled] Item Specific Helph>
USB2.0 Controller [Enabled]
USB Legacy support [Enabled] Enable or Disable USB 1.1
and 2.0 Controller.

USB Controller [Enabled]
Allows you to enable or disable the onchip USB controller.
Configuration options: [Disabled] [Enabled]

USB 2.0 Controller [Enabled]
Allows you to enable or disable the USB 2.0 controller.
Configuration options: [Disabled] [Enabled]

USB Legacy Support [Enabled]
Allows you to enable or disable support for USB devices on legacy operating
systems (OS). Configuration options: [Disabled] [Enabled]
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Onboard 1394 Controller [Enabled]

Allows you to disable or enable the onboard 1394 device support.
Configuration options: [Disabled] [Enabled]

Onboard 1st/2nd nVidia LAN [Enabled]

Enables or disables the onboard NVIDIA® LAN controller.
Configuration options: [Disabled] [Enabled]

OnBoard LAN Boot ROM [Disabled]

Allows you to enable or disable the onboard LAN boot ROM.
Configuration options: [Enabled] [Disabled]

Primary Display Adapter [PCI-E Siot]
Allows you to select the graphics controller to use as the primary boot device.
Configuration options: [PCI Slot] [PCI-E slot]

HD Audio [Auto]

Allows you to disable or set the High-Definition audio function.
Configuration options: [Auto] [Disabled]

Front Panel Support Type [AC97]

Allows you to set the front panel sudio connector (AAFP) mode to legacy AC'97 or
high-definition audio depending on the audio standard that the front panel audio
module supports. Configuration options: [AC97] [HD Audio]

Silicon SATAII Controller [SATA Mode]

Allows you to disable or set the function of the extended SATA Il controller.
Configuration options: [Disabled] [SATA Mode] [RAID Mode]

ASUS ASAP [Disabled]

Allows you to enable or disable the onboard USB flash module for the ASUS ASAP
feature that supports Windows® Vista ReadyBoost™ function.

Configuration options: [Disabled] [Enabled]

Serial Port1 Address [3F8/IRQ4]

Allows you to select the Serial Port1 base address.
Configuration options: [Disabled] [3F8/IRQ4] [2F8/IRQ3] [3E8/IRQ4] [2E8/IRQ3]
[Auto]

Parallel Port Address [378/IRQ7]

Allows you to select the Parallel Port address.
Configuration options: [Disabled] [378/IRQ7] [278/IRQ5] [3BC/IRQ7]
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Parallel Port Mode [EPP]

Allows you to select the Parallel Port mode.
Configuration options: [Normal] [EPP] [ECP] [Bi-Directional]

The ECP Mode Use DMA item becomes user-configurable when the Parallel
Port Mode item is set to [ECP] or [Bi-Directional]

ECP Mode Use DMA [3]
Allows selection of ECP Mode. Configuration options: [1] [3]

4.5 Power menu

The Power menu items allow you to change the settings for the Advanced
Configuration and Power Interface (ACPI) and the Advanced Power Management
(APM). Select an item then press <Enter> to display the configuration options.

Main Advanced EB:Uial Boot  Tools Exit
ACPI Suspend Type [S1&S3] Select Menu
ACPI APIC support [Enabled]
APM Configuration Item Specific Helph

vwv

Hardware Monitor
Select the ACPI state
used for System
Suspend.

451 ACPI Suspend Type [S1&S3]

Allows you to select the Advanced Configuration and Power Interface (ACPI) state
to be used for system suspend.
Configuration options: [S1(POS)] [S3(STR)] [S1&S3]

45.2 ACPI APIC Support [Enabled]

Allows you to enable or disable the Advanced Configuration and Power Interface
(ACPI) support in the Advanced Programmable Interrupt Controller (APIC). When
set to Enabled, the ACPI APIC table pointer is included in the RSDT pointer list.
Configuration options: [Disabled] [Enabled]
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453  APM Configuration

_

APM Configuration Select Menu

Restore on AC Power Loss [Power-Off] Item Specific Helphh

PWR Button < 4 secs [Instant-Off]

Power Up On PCI/PCIE Devices [Disabled]

Power On By External Modems [Disabled] Press [Enter] to

Power On by RTC Alarm [Disabled] select whether or not
x Date(of Month) Alarm 0 to restart the system
X Alarm Time (hh:mm:ss) 0:0:0 after AC power loss.

HPET Support [Enabled]

Power Up By PS/2 Mouse [Disabled]

Power Up By PS/2 Keyboard [Disabled]

Restore on AC Power Loss [Power-Off]

Allows you to enable or disable the Restore on AC Power Loss function.
Configuration options: [Power-Off] [Power-On]

PWR Button < 4 secs [Instant-Off]

Allows you to set the event after the power button is pressed for more than 4
seconds. Configuration options: [Suspend] [Instant-Off]

Power Up On PCI/PCIE Devices [Disabled]

Allows you to enable or disable the PME to wake up from S5 by PCI/PCIE devices
& NV Onboard LAN. Configuration options: [Disabled] [Enabled]

Power On By External Modems [Disabled]

This allows either settings of [Enabled] or [Disabled] for powering up the computer
when the external modem receives a call while the computer is in Soft-off mode.
Configuration options: [Disabled] [Enabled]

% The computer cannot receive or transmit data until the computer and

~ applications are fully running. Thus, connection cannot be made on the first
try. Turning an external modem off and then back on while the computer is off
causes an initialization string that turns the system power on.

Power On By RTC Alarm [Disabled]

Allows you to enable or disable RTC to generate a wake event. When this item is
set to [Enabled], the items “Date (of Month) Alarm” and “Alarm Time (hh:mm:ss)”
become user-configurable with set values.
Configuration options: [Disabled] [Enabled]
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Date (of Month) Alarm [xx]

To set the date of alarm, highlight this item then press <+> or <-> to make the
selection (Min=0; Max=31).

Alarm Time (hh:mm:ss) [xx:xx:xx]

To set the time of alarm, use <Tab> or < ->/ < —> to select a field, then press <+>
or <->to make the selection (Min=0, Max=23 for the hour field; Min=0, Max=59 for
the minutes/seconds field).

HPET Support [Enabled]
Configuration options: [Disabled] [Enabled]

Power Up By PS/2 Mouse [Disabled]

When set to [Enabled], this parameter allows you to use the PS/2 mouse to turn on
the system. This feature requires an ATX power supply that provides at least 1A on
the +5VSB lead. Configuration options: [Disabled] [Enabled]

Power Up By PS/2 Keyboard [Disabled]

Allows you to disable the Power On by PS/2 keyboard function or set specific keys
on the PS/2 keyboard to turn on the system. This feature requires an ATX power
supply that provides at least 1A on the +5VSB lead.

Configuration options: [Disabled] [Space Bar] [Ctrl-ESC] [Power Key]
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454 Hardware Monitor

The items in this sub-menu displays the hardware monitor values automatically
detected by the BIOS. It also allows you to change CPU Q-Fan feature-related
parameters. Select an item then press <Enter> to display the configuration options.

Power

Hardware Monitor Select Menu
CPU Q-Fan Control [Disabled] Item Specific Helphh
x CPU Q-Fan Profile Performance
Chassis Q-Fan Control [Disabled]

x Chassis Q-Fan Profile Performance Press [Enter] to

Vcore Voltage [ 1.39V] enable or disable.
3.3V Voltage [ 2.76V]

5V Voltage [ 4.48V]

12V Voltage [11.32V]

CPU Temperature 42°C

M/B Temperature 41°C

CPU FAN Speed 3068 RPM
CHA FAN1 Speed RPM
CHA FAN2 Speed RPM
CHA FAN3 Speed RPM
CHA FAN4 Speed RPM
PWR_FAN Speed RPM
CHIP_FAN Speed RPM
CPU Fan Speed warning [ 800 RPM]

CPU Q-Fan Control [Disabled]

Allows you to enable or disable the CPU Q-Fan controller.
Configuration options: [Disabled] [Enabled]

cocoocoo

/ The CPU Q-Fan Profile item becomes use-configurable when you enable the
- CPU Q-Fan Control item.

CPU Q-Fan Profile [Performance]

Allows you to set the appropriate performance level of the CPU Q-Fan. When
set to [Optimal], the CPU fan automatically adjusts depending on the CPU
temperature. Set this item to [Silent] to minimize fan speed for quiet CPU fan
operation, or [Performance] to achieve maximum CPU fan speed.
Configuration options: [Performance] [Optimal] [Silent]

Chassis Q-Fan Control [Disabled]

Allows you to enable or disable the chassis Q-Fan controller.
Configuration options: [Disabled] [Enabled]

% The succeeding item becomes user-configurable when you set the Chassis
~ Q-Fan Control item to [Enabled].
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Chassis Q-Fan Profile [Performance]

Allows you to set the appropriate performance level of the chassis Q-Fan. When
set to [Optimal], the chassis fan automatically adjusts depending on the chassis
temperature. Set this item to [Silent] to minimize fan speed for quiet chassis fan
operation, or [Performance] to achieve maximum chassis fan speed.
Configuration options: [Performance] [Optimal] [Silent]

Vcore Voltage, 3.3V Voltage, 5V Voltage, 12V Voltage

The onboard hardware monitor automatically detects the voltage output through
the onboard voltage regulators. Select [Ignored] if you do not want to detect this
item.

CPU Temperature, M/B Temperature

The onboard hardware monitor automatically detects and displays the motherboard
and CPU temperatures. These items are not user-configurable.

CPU Fan Speed

CHA_FAN1/2/3/4 Speed

PWR_FAN Speed

CHIP_FAN Speed

The onboard hardware monitor automatically detects and displays the CPU,
Chassis, power, and chipset fan speeds in rotations per minute (RPM). If any of the
fans is not connected to the motherboard, the field shows 0. These items are not
user-configurable.

CPU Fan Speed warning [ 800 RPM]

Allows you to disable or set the CPU fan warning speed.
Configuration options: [Disabled] [800 RPM] [1200 RPM] [1600 RPM]
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4.6 Boot menu

The Boot menu items allow you to change the system boot options. Select an item
then press <Enter> to display the sub-menu.

Main Advanced ©Power [R:LIJMl Tools Exit
» Boot Device Priority Select Menu
» Removable Drives
» Hard Disk Drives Item Specific Helph
> CDROM Drives
» Boot Settings Configuration Select Boot Device
» Security Priority

4.6.1 Boot Device Priority

Boot Device Priority Select Menu
1st Boot Device [Removable] Item Specific Helphp
2nd Boot Device [Hard Disk]
3rd Boot Device [CDROM]
4th Boot Device [Disabled] Select Your Boot

Device Priority

1st ~ 4th Boot Device [Removable]

These items specify the boot device priority sequence from the available devices.
The number of device items that appears on the screen depends on the number of
devices installed in the system.

Configuration options: [Removable] [Hard Disk] [CDROM] [Disabled]
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4.6.2 Removable Drives

m

Removable Drives Select Menu

1. Floppy Disks Item Specific Helphp

1. Floppy Disks
Allows you to assign a removable drive attached to the system.

4.6.3 Hard Disk Drives

00

Hard Disk Drives Select Menu

1. SATALl: XXXXXXXXX Item Specific Helphh

1. SATA1: XXXXXXXXX
Allows you to assign hard disk drives attached to the system.

4.6.4 CDROM Drives

00

CDROM Drives Select Menu

1. 1st Slave: XXXXXXXXX Item Specific Helph»

1. 1st Slave: XXXXXXXXX
Allows you to assign optical drives attached to the system.
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4.6.5 Boot Settings Configuration

m

Boot Settings Configuration Select Menu
Case Open Warning [Enabled] Item Specific Helphp
Quick Boot [Enabled]
Boot Up Floppy Seek [Disabled]
Bootup Num-Lock [On] Press [Enter] to
Typematic Rate Setting [Disabled] enable or disable.
x Typematic Rate (Chars/Sec) 6
x Typematic Delay (Msec) 250
0S Select For DRAM > 64MB [Non-08S2]
Full Screen LOGO [Enabled]
Halt On [All Errors]

Case Open Warning [Enabled]

Enables or disables the chassis open status feature. Setting to [Enabled] clears
the chassis open status. Refer to section “2.7.2 Internal connectors” for details.
Configuration options: [Disabled] [Enabled]

Quick Boot [Enabled]

Allows you to enable or disable the system quick boot feature. When set to
[Enabled], the system skips certain tests while booting.
Configuration options: [Disabled] [Enabled]

Boot Up Floppy Seek [Disabled]

Enables or disables the floppy seek feature while booting.
Configuration options: [Disabled] [Enabled]

Bootup Num-Lock [On]
Allows you to select the power-on state for the NumLock.
Configuration options: [Off] [On]

Typematic Rate Setting [Disabled]

Allows you to set the keystroke rate. Enable this item to configure the Typematic
Rate (Chars/Sec) and the Typematic Delay (Msec).
Configuration options: [Disabled] [Enabled]

/ The items Typematic Rate (Chars/Sec) and Typematic Delay (Msec) become
- user-configurable when the item Typematic Rate Setting is enabled.

Chapter 4: BIOS setup



Typematic Rate (Chars/Sec) [6]

Allows you to select the rate at which a character repeats when you hold a key.
Configuration options: [6] [8] [10] [12] [15] [20] [24] [30]

Typematic Delay (Msec) [250]

Allows you to set the delay before keystrokes begin to repeat.

Configuration options: [250] [500] [750] [1000]

OS Select for DRAM > 64MB [Non-0S2]

Set this item to OS2 only when you are running on an OS/2 operating system with
an installed RAM of greater than 64 KB. Configuration options: [Non-OS2] [0S2]

Full Screen LOGO [Enabled]

Allows you to enable or disable the full screen logo display feature.
Configuration options: [Disabled] [Enabled]

/ Make sure that the above item is set to [Enabled] if you want to use the ASUS
~ MyLogo3™ feature.

Halt On [All Errors]

Allows you to error report type.
Configuration options: [All Errors] [No Errors] [All, But Keyboard] [All, But Diskette]
[All, But Disk/Key]

4.6.6  Security

m

Security Select Menu
Supervisor Password Clear Item Specific Helph»
User Password Clear
Password Check [Setup]
Security Chip [Disabled] Supervisoripassnord

controls full access,
<Enter> to change
password.

Supervisor Password
User Password

These fields allow you to set passwords:

To set a password:

1. Select an item then press <Enter>.

2. Type in a password using a combination of a maximum of eight (8) alpha-
numeric characters, then press <Enter>.
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3. When prompted, confirm the password by typing the exact characters again,
then press <Enter>. The password field setting is changed to Set.

To clear the password:

1. Select the password field and press <Enter> twice. The following message
appears:

PASSWORD DISABLED !!!
Press any key to continue...

2. Press any key to continue. The password field setting is changed to Clear.

A note about passwords

The Supervisor password is required to enter the BIOS Setup program
preventing unauthorized access. The User password is required to boot the
system preventing unauthorized use.

Forgot your password?

If you forget your password, you can clear it by erasing the CMOS Real Time
Clock (RTC) RAM. The RAM data containing the password information is
powered by the onboard button cell battery. If you need to erase the CMOS
RAM, refer to section “2.6 Jumper” for instructions.

Password Check

This field requires you to enter the password before entering the BIOS setup or the
system. Select [Setup] to require the password before entering the BIOS Setup.
Select [System] to require the password before entering the system.

Configuration options: [Setup] [System]

Security Chip [Disabled]

Allows you to enable or disable the TPM security chip.
Configuration options: [Disabled] [Enabled]

/ The succeeding item appears when you enable the Security Chip item.
Clear TPM Security Chip [Enter]
Allows you to clear the user information saved in the TPM security chip.
When you press <Enter>, a warning message appears to ask if you want to
clear the user information in the security chip. Use the left/right arrow key to
select between [YES] and [NO], then press <Enter> to confirm your choice.

After you select [YES] to execute the Clear TPM Security Chip function, the
° data saved in the TPM security chip will be cleared and can never be restored.
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4.7 Tools menu

The Tools menu items allow you to configure options for special functions. Select
an item then press <Enter> to display the sub-menu.

Main Advanced Power Boot [ReIdEd Exit

> ASUS 0.C. Profile Select Menu
ASUS EZ Flash 2

Item Specific Helph

4.71 ASUS 0.C. Profile

This item allows you to store or load multiple BIOS settings.

Tools

ASUS 0.C. Profile Select Menu

» Load BIOS Profile Item Specific Helphh
> Save BIOS Profile

Press [Enter] to select.

Load BIOS Profile

Tools

Load BIOS Profile Select Menu

Load from Profile 1 Item Specific Helphh
Load from Profile 2

Load from File Load BIOS Profile from

Profile 1.

Load from Profile 1/2

Allows you to load the previous BIOS settings saved in the BIOS Flash. Press
<Enter> to load the file.
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Load from File

Allows you to load the previous BIOS file saved in the hard disk/floppy disk/USB
flash disk with the FAT32/16/12 format. Follow the instructions below to load the
BIOS file.

1. Insert the storage devices that contains the “xxx.CMO” file.
2. Turn on the system.

3. Enter BIOS setup program. Go to the “Tools” menu to select “Load from
File.” Press <Enter> then the setup screen will appear.

4. Press <Tab> to switch between drives before the correct “xxx.CMQO” file
is found. Then press <Enter> to load the file.

5. Apop-up message will inform you when the loading process finishes.

% +  Suggest only to update the BIOS file coming from the same memory/CPU
< configuration and BIOS version.

Only the “xxx.CMO?” file can be loaded.

m

Load BIOS Profile Select Menu

Load from Profile 1 Item Specific Hel,
Load from Profile 2 s >

Load from File Load BIOS Profile from

Profile 1.

Save BIOS Profile

Save BIOS Profile Select Menu

Save to Profile 1 Item 0 Helph»
Save to Profile 2

Save to File Save current BIOS Profile

to Profile 1.
Save to Profle 1/2
Allows you to save the current BIOS file to the BIOS Flash. Press <Enter> to save
the file.
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Save to File

Allows you to save the current BIOS file to the hard disk/floppy disk/USB flash disk
with FAT32/16/12 format. Follow the instructions below to save the BIOS file.

1.
2.

Z

Insert the storage devices with enough space.
Turn on the system.

Enter the BIOS setup program. Go to the “Tools” menu to select “Save to
File.” Press <Enter> then the setup screen will appear.

Press <Tab> to switch between the drives. Press hot-key <S> to save
the file.

Key in the file name. Then press <Enter>.

A pop-up message will inform you when the saving process finishes.

ASUSTek 0.C. Profile Utility B318

Current CMOS Update CMOS
BOARD: M2N32-SLI PREMIUM BOARD: Unknown
VER: 0107 VER: Unknown
DATE: 12/25/2006 DATE: Unknown

PATH: C:\M2N320C

A: CMOS backup is done! Press any key to Exit.

DOCUME" 1 <DIR>
PROGRA"1 <DIR>
SYSTEM"1 <DIR>
M2NSLI <DIR>
RECYCLED <DIR>
TEST REB <DIR>
BOOTFONT.BIN 213830 2001-09-05 20:00:00

Note
[Enter] Select [Y] Yes [N/Eec] No [Left/Right]: Switch I

The BIOS file will be saved as “xxx.CMO*“.
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472  ASUS EZ Flash 2

Allows you to run ASUS EZ Flash 2. When you press <Enter>, a confirmation
message appears. Use the left/right arrow key to select between [Yes] or [No],
then press <Enter> to confirm your choice. Please see page 4-5, section 4.1.3 for
details.

ASUSTek EZ Flash 2 BIOS ROM Utility B318
FLASH TYPE: Winbond W39V080A 8Mb LPC

Current ROM Update ROM
BOARD: M2N32-SLI PREMIUM BOARD: Unknown
VER: 0107 VER: Unknown
DATE: 12/25/2006 DATE: Unknown

Note
[Enter] Select [S] Save [ESC] Exit
[Tab] Switch [Up/Down/Home/End] Move
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4.8 Exit menu

The Exit menu items allow you to load the optimal or failsafe default values for the
BIOS items, and save or discard your changes to the BIOS items.

Main Advanced Power Boot Tools B®SEd

Exit & Save Changes Select Menu
Exit & Discard Changes T
Load Setup Default Item Specific Helph

Discard Changes
This option save data

to CMOS and exiting
the setup menu.

/ Pressing <Esc> does not immediately exit this menu. Select one of the options
~ from this menu or <F10> from the legend bar to exit.

Exit & Save Changes

Once you are finished making your selections, choose this option from the Exit
menu to ensure the values you selected are saved to the CMOS RAM. An onboard
backup battery sustains the CMOS RAM so it stays on even when the PC is turned
off. When you select this option, a confirmation window appears. Select [YES] to
save changes and exit.

/ If you attempt to exit the Setup program without saving your changes, the
— program prompts you with a message asking if you want to save your changes
before exiting. Press <Enter> to save the changes while exiting.

Exit & Discard Changes

Select this option only if you do not want to save the changes that you made to the
Setup program. If you made changes to fields other than System Date, System
Time, and Password, the BIOS asks for a confirmation before exiting.

Load Setup Defaults

This option allows you to load the default values for each of the parameters on the
Setup menus. When you select this option or if you press <F5>, a confirmation
window appears. Select [YES] to load default values. Select [Exit & Save Changes]
or make other changes before saving the values to the non-volatile RAM.

Discard Changes

This option allows you to discard the selections you made and restore the
previously saved values. After selecting this option, a confirmation appears. Select
[YES] to discard any changes and load the previously saved values.
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This chapter describes the contents of
the support DVD that comes with the
motherboard package.

Software
support
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5.1 Installing an operating system

This motherboard supports Windows® 2000/2003 Server/XP/64-bit XP/Vista/64-
bit Vista operating systems (OS). Always install the latest OS version and
corresponding updates to maximize the features of your hardware.

/ +  Motherboard settings and hardware options vary. Use the setup
procedures presented in this chapter for reference only. Refer to your OS
documentation for detailed information.

+ Make sure that you install Windows® 2000 Service Pack 4 or the Windows®
XP Service Pack2 or later versions before installing the drivers for better
compatibility and system stability.

5.2 Support DVD information

The support DVD that came with the motherboard package contains the drivers,
software applications, and utilities that you can install to avail all motherboard
features.

/ The contents of the support DVD are subject to change at any time without
notice. Visit the ASUS website(www.asus.com) for updates.

5.2.1 Running the support DVD

Place the support DVD to the optical drive. The DVD automatically displays the
Drivers menu if Autorun is enabled in your computer.
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Click an icon to
display support
DVD/motherboard
information

Click an item to install

/ If Autorun is NOT enabled in your computer, browse the contents of the support
< DVD to locate the file ASSETUP.EXE from the BIN folder. Double-click the
ASSETUP.EXE to run the DVD.
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5.2.2 Drivers menu

The drivers menu shows the available device drivers if the system detects installed
devices. Install the necessary drivers to activate the devices.

Drivers

-

-

ASUS InstAll - Drivers Installation Wizard

Installs all of the drivers through the installation wizard.

AMD Cool ‘n’ Quiet Driver

Installs the AMD Cool ‘n’ Quiet™ technology driver.

Nvidia Chipset Driver Program

Installs the NVIDIA® Chipset drivers for the NVIDIA® nForce™ 590 SLI chipset.

SoundMAX ADI1988 Audio Driver
Installs the SoundMAX® ADI1988 audio driver and application.

Silicon Image SATA Driver
Installs the Silicon Image® Serial ATA RAID driver.

USB 2.0 Driver
Installs the Universal Serial Bus 2.0 (USB 2.0) driver.
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5.2.3 Utilities menu

The Utilities menu shows the applications and other software that the motherboard
supports.

Utilities

P smus wom ot Limiion 5 B pioghet
b

Click to display
the next screen

Utilities

Wi i w8 L e B ¢ gl
b

Click to display
the previous
screen

ASUS InstAll - Installation Wizard for Utilities
Installs all of the utilities through the installation wizard.
ASUS Cool ‘n’ Quiet Utility

Installs the AMD Cool ‘n’ Quiet™ software.

ASUS PC Probe I

This smart utility monitors the fan speed, CPU temperature, and system voltages,
and alerts you of any detected problems. This utility helps you keep your computer
in healthy operating condition.
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ASUS Update

The ASUS Update utility allows you to update the motherboard BIOS in Windows®
environment. This utility requires an Internet connection either through a network
or an Internet Service Provider (ISP).

% Before using the ASUS Update, make sure that you have an Internet connection
- so that you can connect to the ASUS website.

ASUS Al Suite
Installs the ASUS Al Suite.

ASUS Accelerated Propeller
Installs the ASUS Accelerated Propeller (ASAP).

Adobe Reader V7.0

Installs the Adobe® Acrobat® Reader that allows you to open, view, and print
documents in Portable Document Format (PDF).

Microsoft DirectX 9.0c

Installs the Microsoft® DirectX 9.0c driver. The Microsoft DirectX® 9.0c is a
multimedia technology that enhances computer graphics and sound. DirectX®
improves the multimedia features of you computer so you can enjoy watching
TV and movies, capturing videos, or playing games in your computer. Visit the
Microsoft website (www.microsoft.com) for updates.

Anti-Virus Utility

The anti-virus application scans, identifies, and removes computer viruses. View
the online help for detailed information.

InterVideo MediaOne Gallery
Installs the InterVideo MediaOne Gallery software.

WinDVD Copy5 Trial
Installs the WinDVD Copy5 Trial version.

Ulead Photolmpact 12 SE
Installs the Ulead Photolmpact 12 SE software.

CyberLink PowerBackup
Installs the CyberLink PowerBackup software.

Corel Snapfire Plus SE
Installs the Corel Snapfire Plus SE software.
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5.2.4 Make Disk menu

The Make Disk menu contains items to create the NVIDIA® nForce™ 590-SLI or
Silicon Image SATA/RAID driver disk.

Make disk

TPy ot s | F e R
L

Make NV SATA/RAID 32bit Driver

Allows you to create an NVIDIA® Serial ATA RAID driver disk for a 32-bit system.

Silicon Image 32/64bit RAID/SATA Driver

Allows you to create a Silicon Image® Serial ATA/RAID driver disk for a 32/64-bit
system
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5.2.5 Manual menu

The Manual menu contains a list of supplementary user manuals. Click an item to
open the folder of the user manual.

% Most user manual files are in Portable Document Format (PDF). Install the
Adobe® Acrobat® Reader from the Utilities menu before opening a user manual
file.
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5.2.6 ASUS Contact information

Click the Contact tab to display the ASUS contact information. You can also find
this information on the inside front cover of this user guide.
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Contact
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5.2.7 Other information

The icons on the top right corner of the screen give additional information on the
motherboard and the contents of the support DVD. Click an icon to display the
specified information.

Motherboard Info
Displays the general specifications of the motherboard.

Drivers

P s et a1 P g

Browse this DVD
Displays the support DVD contents in graphical format.
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Technical support Form

Displays the ASUS Technical Support Request Form that you have to fill out when
requesting technical support.

ERrETEE

Filelist

Displays the contents of the support DVD and a brief description of each in text
format.
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5.3 Software information

Most of the applications in the support DVD have wizards that will conveniently
guide you through the installation. View the online help or readme file that came
with the software application for more information.

5.3.1 ASUS MyLogo3™

The ASUS MyLogo3™ utility lets you customize the boot logo. The boot logo is the
image that appears on screen during the Power-On Self-Tests (POST). The ASUS
MyLogo3™ is automatically installed when you install the ASUS Update utility from
the support DVD. See section “5.2.3 Utilities menu” for details.

R +  Before using the ASUS MyLogo3™, use the Award BIOS Flash utility to
make a copy of your original BIOS file, or obtain the latest BIOS version
from the ASUS website. See section 4.1.4 Updating the BIOS.

+ Make sure that the BIOS item Full Screen Logo is set to [Enabled] if
you wish to use ASUS MyLogo3. See section 4.6.5 Boot Settings
Configuration.

You can create your own boot logo image in GIF, or BMP file formats.

The file size should be smaller than 150 K.

To launch the ASUS MyLogo3™:

1. Launch the ASUS Update utility. Refer to section “4.1.1 ASUS Update utility”
for details.

2. Select Options from the drop down menu, then click Next.

Check the option Launch MyLogo to replace system boot logo before
flashing BIOS, then click Next.

Select Update BIOS from a file from the drop down menu, then click Next.

5. When prompted, locate the new
BIOS file, then click Next. The ASUS
MyLogo window appears.

6. From the left window pane, select the

folder that contains the image you
intend to use as your boot logo.

ASUS M2N32-SLI Premium Vista Edition
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10.

When the logo images appear on the
right window pane, select an image to
enlarge by clicking on it.

Adjust the boot image to your desired
size by selecting a value on the Ratio
box.

When the screen returns to the ASUS Update utility, flash the original BIOS to

load the new boot logo.

After flashing the BIOS, restart the computer to display the new boot logo

during POST.
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5.3.2  Cool ‘n’ Quiet!™ Technology

The motherboard supports the AMD Cool ‘n’ Quiet!™ Technology that dynamically
and automatically change the CPU speed, voltage, and amount of power
depending on the task the CPU performs.

Enabling Cool ‘n’ Quiet!™ Technology
To enable Cool ‘n’ Quiet!™ Technology:

1. Turn on the system and enter BIOS by pressing the <Del> key during the
Power On Self-Tests (POST).

2.  Go to Advanced > CPU Configuration > AMD Cool ‘n’Quiet function and
set it to [Enabled]. See section “4.4 Advanced Menu.”

3. Save your changes and exit BIOS Setup.

4. Reboot your computer and set your Power Option Properties depending on
your operating system.

Windows® 2000/XP

1. From the Windows® 2000/XP operating system, click Start. Select Settings >
Control Panel.

2. Make sure the Control Panel is set to Classic View.

3.  Double-click the Display icon in the Control Panel then select the Screen
Saver tab.

Click the Power button. The following dialogue box appears.

5.  From the Power schemes combo list box, select Minimal Power
Management.

6. Click OK to effect settings.

Fowe Uplicm oparian id ]
Prortd Libuiwmin | o] | 113
o @ Saleci s g hans el e e sppnonsts sengs

S B crenpeie Roks bl changing e nsrgn hesoe sl mncdie
B 1alected 1chans
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% + Make sure to install the AMD Cool ‘n’ Quiet!™ driver and application before
& using this feature.

+ The AMD Cool ‘n’ Quiet!™ technology feature works only with the AMD
heatsink and fan assembly with monitor chip

If you purchased a separate heatsink and fan package, use the ASUS
Q-Fan technology feature to automatically adjust the CPU fan speed
according to your system loading.

Launching the Cool ‘n’ Quiet!™ software

The motherboard support DVD includes the Cool ‘n’ Quiet!™ software that enables
you to view your system’s real-time CPU Frequency and voltage.

R Make sure to install the Cool ‘n’ Quiet!™ software from the motherboard support
DVD. Refer to section 5.2.3 Utilities menu for details.

To launch the Cool ‘n’ Quiet!™ program:

1. If you are using Windows® 2000, click the Start button. Select Programs >
ASUS > Cool & Quiet > Cool & Quiet.

2. If you are using Windows® XP, click the Start button. Select All Programs >
ASUS > Cool & Quiet > Cool & Quiet.

3. The Cool ‘n’ Quiet!™ technology screen appears and displays the current
CPU Frequency and CPU Voltage.
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5.3.3  SoundMAX® High Definition Audio utility

The ADI AD1988B High Definition Audio CODEC provides 8-channel audio
capability through the SoundMAX® audio utility with AudioESP™ software to deliver
the ultimate audio experience on your PC. The software implements high quality
audio synthesis/rendering, 3D sound positioning, and advanced voice-input
technologies.

Follow the installation wizard to install the ADI AD1988B Audio Driver from the
support DVD that came with the motherboard package to activate the SoundMAX®
audio utility.

You must use 4-channel, 6-channel or 8-channel speakers for this setup.
Refer to page 1-9 for the OS that supports SoundMAX®.

Jack Retasking function works on High Definition front panel audio ports
only.

If the SoundMAX® audio utility is correctly installed, you
will find the SoundMAX® icon on the taskbar. _H :i %@'@ n
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From the taskbar, double-click on the SoundMAX® icon to display the SoundMAX®
Control Panel.

S Plavbatk Boundbis HD Audic

T ol 0 Player M
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Ferond: SoundeAd HD Audio
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Audio Setup Wizard

By clicking the icon from the SoundMAX® control panel, you can easily
configure your audio settings. Simply follow succeeding screen instructions and
begin enjoying High Definition Audio.
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Jack configuration Adjust speaker volume

This screen helps you configure your This screen helps you adjust speaker
computer’s audio ports, depending on volume. Click the Test button to hear
the audio devices you have installed. the changes you have made.

Adjunt Speaker Volume

Adjust microphone volume

This screen helps you adjust microphone volume. You will be asked to read pre-
written text to allow the AudioWizard to adjust the volume as you speak.

Adjunt Microphane Waolume
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Audio preferences

Y
Click the icon to go to the Preferences page. This page allows you to change
various audio settings.

General options

Click the General tab to choose your playback and recording devices, enable/
disable the AudioESP™ feature, and enable/disable digital output.

Listening options
Click the Listening Environment tab to optimize your speaker output settings.
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Microphone options
Click the Microphone tab to optimize your microphone input settings.

‘Exm trcinal weir sy son

Enhanced Microphone features

Noise Filtering
Enables Noise Filter function. Detects repetitive and stationary noises like

computer fans, air conditioners, and other background noises then eliminates
it in the incoming sudio stream while recording. You can enable it for a better
recording quality.

Directional Array
Receives only the sound coming from the reception cone and eliminates

interferences including neighboring speakers and reverberations. You can
enable it to transit clearer sound during on-line games, MSN, or Skype.

Speaker Phone

Advanced de-reverberation techniques can help to reduce echo and minimize
its effect on the speech engine. You can enable it when you have conference
call to reduce echoes in the other side.

R +  The directional Array and Speaker Phone
function only when working with the ASUS
Array Mic.

If you are using Windows® Vista, you have
to manually enable the directional Array
and Speaker Phone function. Go to Control
panel > Sound. Click the Recording tab on
the top and select Microphone. Click the
Microphone Enhancement tab and check
Array Mic.
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5.34 ASUS PC Probe Il

PC Probe Il is a utility that monitors the computer’s vital components, and detects
and alerts you of any problem with these components. PC Probe Il senses fan
rotations, CPU temperature, and system voltages, among others. Because PC
Probe Il is software-based, you can start monitoring your computer the moment
you turn it on. With this utility, you are assured that your computer is always at a
healthy operating condition. Refer to page 1-9 for the OS that supports this utility.

Installing PC Probe Il
To install PC Probe Il on your computer:

1. Place the support DVD to the optical drive. The Drivers installation tab
appears if your computer has an enabled Autorun feature.

% If Autorun is not enabled in your computer, browse the contents of the support
L DVD to locate the setup.exe file from the ASUS PC Probe Il folder. Double-click
the setup.exe file to start installation.

2. Click the Utilities tab, then click ASUS PC Probe II.
3. Follow the screen instructions to complete installation.

Launching PC Probe I

You can launch the PC Probe Il right after installation or anytime from the
Windows® desktop.

To launch the PC Probe Il from the Windows® desktop, click Start > All Programs
> ASUS > PC Probe Il > PC Probe Il v1.xx.xx. The PC Probe Il main window
appears.

After launching the application, the PC Probe Il icon appears in the Windows®
taskbar. Click this icon to close or restore the application.

Using PC Probe i

Main window

The PC Probe Il main window
allows you to view the current
status of your system and change
the utility configuration. By
default, the main window displays
the Preference section. You can
close or restore the Preference
section by clicking on the triangle on the main window right handle.

Click to close the
Preference panel
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Button Function

Neonrzdd, | Opens the Configuration window
pTE LN Opens the Report window
“:,ﬂb Opens the Desktop Management Interface window
ECr Opens the Peripheral Component Interconnect window
g Opens the Windows Management Instrumentation window
USF'?P"_- Opens the hard disk drive, memory, CPU usage window
b Shows/Hides the Preference section
(= Minimizes the application
& Closes the application
Sensor alert

When a system sensor detects a problem, the main window right handle
turns red, as the illustrations below show.

When displayed, the monitor panel for that sensor also turns red. Refer to the
Monitor panels section for details.

Preferences
You can customize the application using the
Preference section in the main window. Click ool | Lnbeeieg Erwecrarmst | M
the box before each preference to activate or : )
deactivate il o
' M ey
W Byenth
WA CD Plape
| M crophone

ASUS M2N32-SLI Premium Vista Edition

5-19



Hardware monitor panels

The hardware monitor panels display the current value of a system sensor such as
fan rotation, CPU temperature, and voltages.

The hardware monitor panels come in two display modes: hexagonal (large) and
rectangular (small). When you check the Enable Monitoring Panel option from the
Preference section, the monitor panels appear on your computer’s desktop.

& CPU

 crU &0 |
I 294 Rpmlj

Small display

Large display

Changing the monitor panels position

To change the position of the monitor panels in the desktop,
click the arrow down button of the Scheme options, then select
another position from the list box. Click OK when finished.

Moving the monitor panels
All monitor panels move together using a magnetic effect. If
you want to detach a monitor panel from ==
the group, click the horseshoe magnet ¥ CPU
icon. You can now move or reposition the

panel independently. |

Adjusting the sensor threshold value /4 CPU
You can adjust the sensor threshold J

value in the monitor panel by

clicking the or buttons. You can Click to
also adjust the threshold values inerease

> . ’ value
using the Config window.
) Click t
You cannot adjust the sensor decrease
threshold values in a small value

monitoring panel.
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Monitoring sensor alert
The monitor panel turns red when a component value exceeds or is lower

than the threshold value. Refer to the illustrations below.

¥oHasss B0

Small display

Large display

WMI browser

Click ™. to display the

WMI (Windows Management
Instrumentation) browser. This
browser displays various Windows®
management information. Click an i
item from the left panel to display on it )
the right panel. Click the plus sign (+)
before WMI Information to display the
available information.

WMI Browger

Vs | A

e i) 20N ALYY

/ You can enlarge or reduce the browser size by dragging the bottom right corner
L of the browser.

DMI browser

DMI$

Click =555 to display the DMI
(Desktop Management Interface)
browser. This browser displays various

OMI Ercerser

desktop and system information. e
Click the plus sign (+) before DMI bk
Information to display the available ke

Clgmerght iy M, 295

information.
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PCI browser

Click F= to display the PCI e
(Peripheral Component Interconnect) e
browser. This browser provides AT Browser

information on the PCI devices installed
on your system. Click the plus sign

(+) before the PCI Information item to
display available information.

Faripharal Companent

Tnterconnect

_—_
SRR A

Usage
The Usage browser displays real-time information on the CPU, hard disk drive
space, and memory usage. Click Y% to display the Usage browser.

CPU usage
The CPU tab displays real-

time CPU usage in line graph
representation. If the CPU has
an enabled Hyper-Threading,
two separate line graphs display
the operation of the two logical
processors.

Hard disk drive space usage
The Hard Disk tab displays the
used and available hard disk
drive space. The left panel of the
tab lists all logical drives. Click

a hard disk drive to display the
information on the right panel.
The pie chart at the bottom of
the window represents the used —
(blue) and the available HDD —
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Memory usage

The Memory tab shows both used
and available physical memory. The
pie chart at the bottom of the window
represents the used (blue) and the
available physical memory.

Configuring PC Probe I
Click “#™™=.t0 view and adjust the sensor threshold values.

The Config window has two tabs: Sensor/Threshold and Preference. The Sensor/

Threshold tab enables you to activate the sensors or to adjust the sensor threshold

values. The Preference tab allows you to customize sensor alerts, or change the
temperature scale.

Loads the default

threshold values for Cancels or Loads your saved
each sensor ignores your configuration
Applies your changes Saves your
changes configuration
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5.3.5  ASUS Al Suite

ASUS Al Suite allows you to launch Al Gear, Al N.O.S., Al Booster, Al Nap, and
Q-Fan utilities easily.

Installing Al Suite

To install Al Suite on your computer:

1. Place the support DVD to the optical drive. The Drivers installation tab
appears if your computer has an enabled Autorun feature.

2. Click the Utilities tab, then click Al Suite.

3. Follow the screen instructions to complete installation.

Launching Al Suite

You can launch the Al Suite right after installation or anytime from the Windows®
desktop.

To launch the Al Suite from the Windows® desktop, click Start > All Programs >
ASUS > Al Suite > Al Suite v1.xx.xx. The Al Suite main window appears.

After launching the application, the Al Suite icon appears in the Windows® taskbar.
Click this icon to close or restore the application.

Using Al Suite

Click the AI N.O.S., Al Gear, Al Nap, Al Booster, or Q-Fan icon to launch the utility,
or click the Normal icon to restore the system to normal state.

i  ————lh

AI SUITE

Press to restore to normal

[ - Press to launch Al Nap
Narmal a —— Press to launch AI N.O.S.

' LI . Press to launch Q-Fan

(V- )

Press to launch Al Gear

Press to launch Al Booster
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Other feature buttons

Click H on right corner of the main window to open the monitor window.

>

Displays the CPU/
system temperature,
— CPU/memory/PCIE
voltage, and CPU/
chassis fan speed

. Displays the FSB/CPU
frequency

Click E on right corner of the expanded window to switch the temperature from
degrees Centigrade to degrees Fahrenheit.

F5l 053150

3189.48..

QIiEmn X #40
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53.6  ASUSAIN.O.S.

This ASUS Non-delay Overclocking System feature intelligently determines the
system load and automatically boosts the performance for the most demanding
tasks.

After installing Al Suite from the bundled support DVD, you can launch the utility
by double-clicking the Al Suite icon on the Windows OS taskbar and click the Al
N.O.S. button on the Al Suite main window.

HL0LS mede: drop-down menu
Diabia — ____ button

.'i! !FI

Click the drop-down menu button and select Disable or Manual.

N05 mode

L=1

[T — (=
O ~ selectan N.O.S.

Ml ) ‘ mode
|

II\ JI

Click Apply at the bottom to save the configuration.

% Refer to page 1-9 for the OS that supports this utility.

5-26 Chapter 5: Software support



5.3.7 ASUS Al Gear

ASUS Al Gear provides four system performance options that allows you to select
the best performance setting for your computing needs. This easy-to-use utility
adjusts the processor frequency and vCore voltage to minimize system noise and

power consumption.

After installing Al Suite from the bundled support DVD, you can launch Al Gear by
double-clicking the Al Suite icon on your Windows OS taskbar and then click the Al

Gear button on the Al Suite main window.

Shift the gear to the performance setting that you like.

e

Maximum

Performance

Petfarmance:

4

High Maximum
Performance Power Saving

/ﬁ Refer to page 1-9 for the OS that supports this utility.

ASUS M2N32-SLI Premium Vista Edition
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Performance
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5.3.8  ASUS Al Nap

This feature allows you to minimize the power consumption of your computer
whenever you are away. Enable this feature for minimum power consumption and
a more quiet system operation.

After installing Al Suite from the bundled support DVD, you can launch the utility by
double-clicking the Al Suite icon on the Windows OS taskbar and click the Al Nap
button on the Al Suite main window.

Click Yes on the confirmation screen.

i

Aue you sure that you want bo enter Al Map
mode?

To exit Al Nap mode, press the system power or mouse button then click Yes on
the confirmation screen.

Al Nap ‘
Are you sure that pou want ta leave Al Map
mode?
| Yes ] I Ma ]
' ' |

+  To switch the power button functions from Al Nap to shutting down, just
right click the Al Suite icon on the OS taskbar, select Al Nap and click Use
power button. Unclick the item to switch the function back.

+  Refer to page 1-9 for the OS that supports this utility.
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5.3.9 ASUS Al Booster

The ASUS Al Booster application allows you to overclock the CPU speed in
WIindows® environment without the hassle of booting the BIOS.

After installing Al Suite from the bundled support DVD, you can launch the utility
by double-clicking the Al Suite icon on the Windows® OS taskbar and click the Al
Booster button on the Al Suite main window.

Moxle:
[ Default: Auto

The options on the taskbar allow you to use the default settings, adjust CPU/
Memory/PCI-E frequency manually, or create and apply your personal overclocking
configurations.

% Refer to page 1-0 for the OS that supports this utilty.
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5.3.10 ASUS Q-Fan

This ASUS Q-Fan Control feature allows you to set the appropriate performance
level of the CPU Q-Fan or the Chassis Q-Fan for more efficient system operation.
After enabling the Q-Fan function, the fans can be set to automatically adjust
depending on the temperature, to decrease fan speed, or to achieve the maximum
fan speed.

After installing Al Suite from the bundled support DVD, you can launch the utility by
double-clicking the Al Suite icon on the Windows® OS taskbar and click the Q-Fan
button on the Al Suite mAIn window.

Click the drop-down menu button and display the fan names. Select CPU Q-FAN
or CHASSIS Q-FAN. Click the box of Enable Q-Fan to activate this function.

drop-down list
Enable button

Q-Fan box

Lo

4.9 Ll

Profile list appears after clicking the Enable Q-Fan box. Click the drop-down
list button and select a profile. Optimal mode makes the fans adjust speed
with the temperature; Silent mode minimizes fan speed for quiet fan operation;
Performance mode boosts the fan to achieve maximal fan speed for the best
cooling effect.

click to display the drop-
down list and select a
Q-Fan mode

Click Apply at the bottom to save the setup.
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5.3.11 Al Remote

With the ASUS Al Remote, you can play, pause, or adjust the volume on any songs
desired without leaving your sofa. Have Al Remote in your hand and do more with
your PC at a distance away.

Overview of the ASUS Al Remote

1
1. Power h F, =]
I— 3. Al Gear
2. Full Screen ————— = m e 4. Al Nap
5. AP-1/2 Trigger . .
et = e 6. AP Menu
+———— Volume Up

Play/Pause
Next
Previous

7. Media Control Zone

I-dl-l il e

= ——— Volume Down

1. Power: Turns the computer on/off.

2. Full Screen: Puts the media application into full screen.

3. Al Gear: Changes modes for optimizing performance and quietness.
4. Al Nap: Snoozing system without terminating tasks into quietest state.
5. AP-1/2 Trigger: Initiates the pre-defined applications.

6. AP Menu: Displays the application menu.

7. Media Control Zone: Controls the media application.
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USB IR Receiver

Your motherboard will come bundled with a IR Receiver, simply connect the USB
end to your PC USB ports under the LAN2 port and place the IR receiver end at a
suitable place without hindrance.

0
IR Receiver

(X

O o |
I
USB Ports
|— Infrared end

/ +  The valid IR function distance is 6m depending on the environment.

~ Suggest you to aim at the IR receiver when using the ASUS Al Remote to
ensure a smooth and successful operation.

+  These two USB ports support USB wake-up capability. So when the
computer is not turned on, removing USB devices such as the ASUS IR
receiver from these two ports will start up the PC.

+  Back I/O differs depending on the motherboards.

+ Refer to page 1-9 for the OS that supports the ASUS Al Remote.

Software Installation

3

Before enjoying the convenience the e e e
ASUS Al Remote brings you, you need e S —

to install the software after the infrared Drivers 3

receiver installation. Simply click and ey _ P,

install the file ASUS Al Remote from
the Drivers menu of the Motherboard
Support DVD package for the first
time, and it will launch automatically
everytime you start up your PC.

ASUS Al Remote
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Activating HID-Compliant Devices

Due to the limitation of the operating system, if you remove the IR receiver from
the previous port and have it reinstall into the other USB port, the IR receiver will
not function. To activate the HID-compliant devices again, go to Device Manager/
Power Manager and check the box of Allow this device to bring the computer
out of standby.

& 3% II.!-

1. Click Windows icon and 2. Double click System and
choose Control Panel. Maintenance.

P

B&Ey & n

3. Click Device Manager. 4.  Select HID-compliant device.

o T

Jite =

5. Check the box of Allow this
device to wake the computer.
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ASUS Al Remote Settings

After the installation of the ASUS Al Remote software, the utility screen will show
up and allows you to configure the ASUS Al Remote settings. Set up the function
keys following the instructions below.

-
| e

2 2r .
| B

1. Power On / Off Key

Enable power key
Click this box to enable this power button.

Enable power on after power loss

Click this box to restart the system after the AC power loss. Whenever the power
cord of your PC is removed from the outlet or there is a power failure, your PC will
auto-boot and shut down around few seconds to enable the Power On function of Al
Remote after the power supply is back.

Function switch

You can customize the Power key by switching the mode from Power off to
Hibernate or Standby based on your preference. Setting this item to Hibernate
allows you to lead your PC to the Windows S4 mode, which enables your PC to
enter Hibernate faster and return to full power much more quickly.

% + Power On/Off button does not support MS-DOS Mode.

< +  You have to check the box of Enable Power Key before using the ASUS Al
Remote to turn on and off your PC or to have it hibernate or standby. Visit
www.microsoft.com for details about Hibernate and Standby.
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2.AP-1/2

You are allowed to configure two sets of applications for AP-1 Trigger and
AP-2 Trigger buttons. After the setup, you can easily launch the pre-defined
application by pressing the designated button.

(1) Click the box before Use Profile, and you are able to select a default
application from the drop-down menu.

(2) To launch a non-default application, unclick the box before Use Profile.

(8) Click the Browse button and locate the executable (.exe) file of the
application you want to launch by pressing the AP-1 button.

(4) Follow the same instructions to configure the AP-2 button.

(5) Click Save to save the configuration.

3. Multimedia Keys
Profile

There are nine default applications in the Profile drop-down menu and five sets of
User Define.

/ Default applications are Media Player, iTunes, PowerDVD, WinDVD, QuickTime,
/- Real Player, DivX Player, WinAmp and Power Point. (Default applications in the
ASUS Al Remote software may change without notice.)

Path

The software will help locate the executable (.exe) file of the nine default
applications. If the .exe file is not located, click Browse to direct the correct path.
The .exe files of the User Define applications need to be located manually before
you using the ASUS Al Remote.

% +  Save after the .exe file path is directed.
+  Ifthe executable file is relocated or the application is re-installed, you have

to redirect the file path for a correct ASUS Al Remote operation.
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AP Menu Button and Application menu
Navigate with the media control zone.

upward

leftward rightward

enter
downward

Select Application Profile
After you press = (AP Menu) on the

remote control, an application profile
will be displayed on the screen. Use
the remote control to navigate and
initiate a desired application.

Select Application Profile

lect Application Path
If the software fails to locate the
executable file of the applicaton
at the first-time use, the Select
Application Path screen will appear.
Specify the correct path on screen.

Salect Application Path

"
¥

lect Fil
After selecting the correct path, you
should select the correct executable
file (.exe) of the application for
launching the application.

If the executable file is located by the
software successfully or you have
already set up correctly in advance,
this screen will show up directly
when the application is chosen.

After selecting a desired file, folder
or CD-ROM, use 1e«/ pp1 to choose
Back/OK/Cancel and then press

»u to confirm.

% +  For music listening, making playlists beforehand is suggested.
- +  Press = again to close the application and again to re-launch the profile
menu.
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Define Hotkeys for Application

If you want to use the Media Control Zone to control non-default applications, such
as ACDSee, you can select User Define from the drop-down menu and rename
it by pressing Rename. The ASUS Al Remote software has correctly set up nine
popular applications and defined the funtion buttons for your convenient operation.

User Define

After clicking the box before Use @i tesss pwesies
Hotkeys for Application, you are ~ f=weer=s
free to define the hotkeys of the A
User Define applications. o

e | i
s : —-—
- —l
Mrr= |
Brref 3 Druam| Sea | ey |
|- ol
Select User Define 1~5 from -ﬁ'“__: o
the Profile drop-down menu for ..L‘:.ET"'_""
hotkeys definition. Press Save P
to save the new setup or press B i o
the Default button to clear ALL e
personalized setups and restore to B mai 5
the original definitions.
[ i
—

+  The remote control buttons will function only when the definitions of the
application hotkeys are correct.

The hotkey definitions may vary with different software versions. Click the
box of Redefine default hotkeys to give new correct definitions if needed.
Press Save button to save the redefinitions or press Reset button to restore
to the default hotkeys definition.

After the initial setup, you will find an ASUS Al Remote icon [gj on the
Windows OS taskbar. Click the icon and select Settings to launch the utility
screen.
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The Function Buttons and AP Profile

The ASUS Al Remote software helps you set up the correspondence between the
function buttons on the remote to the function hotkeys of nine popular applications
in advance and leaves five sets for User Define.

Media Player | iTunes PowerDVD | WinDVD QuickTime
Full Screen |v \ v v %
>l \ \% VI \ v
+ v % % % %
- % % % % %
[ % % % v X
[Pw) v v v v X
*NOTE only play, no pause
Real Player | DivX Player |WinAmp Power Point | User Deflne
Full Screen |v v X v
>l v v v/IX Full Screen
+ v X \ B
- v X v ESC
i % X \ Page Down
> v X v Page Up
*NOTE only play, no pause

If you find the 9 default applications insufficient and would like to add different
applications, you are able to rename the 5 sets User Define and create your
preferred applications and favorable setups.
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5.4 Windows® Vista feature

5.4.1 ASAP (ASUS Accelerated Propeller)

This motherboard is equipped with the ASUS Accelerated Propeller (ASAP)
feature. ASAP supports the Windows® ReadyBoost™ technology that improves
system performance under Windows® Vista. Refer to page 1-9 for the OS that
supports ASAP.

AR Before activating ASAP, install the ASAP utility from the bundled support DVD.

To activate ASAP:

1. From the Windows® Vista desktop, [y — &=
click Start > Computer. ] [y ey e gy pe—

2. Right-click on the USB Removable B, toem o s ety usorg e st e
Storage device (ASAP), and select ; =
Properties. RN

i 5 resnan for reviee mesd

3.  Click the ReadyBoost tab. A dialog
box appears.

4.  Check Use this device, and then
move the slider to determine the ot el ol e e s
amount of space researved for s enmpn o
ReadyBoost " cache. "

5.  Click OK to effect the settings.

;3 e

R + When you see the existing partition for ASAP, we advise you not to delete
this partition that supports the ReadyBoost™ function. If you delete this
partition by accident, you may recreate it by:

Clicking Start from the Windows® Vista desktop. Right-click on Computer
and select Manage. Click Disk Management and right-click on the ASAP
drive. Select Format > OK. OR

Going to Start > Control Panel > System and Maintenance >
Administrative Tools > Computer Management > Disk Management.
Right-click on the ASAP drive, and select Format > OK.

If you accidentally remove the ASAP device from Windows® Vista, you may
re-activate it by rebooting your computer.

+ If you want to reinstall an operating system, uninstall the ASAP utility first.
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5.5 RAID configurations

The motherboard comes with the Silicon Image Sil3132 and the NVIDIA®
nForce”™ 590 SLI Southbridge RAID controllers that allow you to configure Serial
ATA hard disk drives as RAID sets. The motherboard supports the following RAID
configurations.

RAID 0 (Data striping) optimizes two identical hard disk drives to read and write
data in parallel, interleaved stacks. Two hard disks perform the same work as a
single drive but at a sustained data transfer rate, double that of a single disk alone,
thus improving data access and storage. Use of two new identical hard disk drives
is required for this setup.

RAID 1 (Data mirroring) copies and maintains an identical image of data from one
drive to a second drive. If one drive fails, the disk array management software
directs all applications to the surviving drive as it contains a complete copy of

the data in the other drive. This RAID configuration provides data protection and
increases fault tolerance to the entire system. Use two new drives or use an
existing drive and a new drive for this setup. The new drive must be of the same
size or larger than the existing drive.

RAID 0+1 is data striping and data mirroring combined without parity (redundancy
data) having to be calculated and written. With the RAID 0+1 configuration you get
all the benefits of both RAID 0 and RAID 1 configurations. Use four new hard disk
drives or use an existing drive and three new drives for this setup. (For NF-590 SLI

only)

RAID 5 stripes both data and parity information across three or more hard

disk drives. Among the advantages of RAID 5 configuration include better

HDD performance, fault tolerance, and higher storage capacity. The RAID

5 configuration is best suited for transaction processing, relational database
applications, enterprise resource planning, and other business systems. Use a
minimum of three identical hard disk drives for this setup. (For NF-590 SLI only)

JBOD (Spanning) stands for Just a Bunch of Disks and refers to hard disk drives
that are not yet configured as a RAID set. This configuration stores the same data
redundantly on multiple disks that appear as a single disk on the operating system.
Spanning does not deliver any advantage over using separate disks independently
and does not provide fault tolerance or other RAID performance benefits.
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K If you want to boot the system from a hard disk drive included in a RAID set,
copy first the RAID driver from the support DVD to a floppy disk before you
install an operating system to a selected hard disk drive. Refer to section 5.6
Creating a RAID driver disk for details.

5.5.1 Installing hard disks

The motherboard supports Serial ATA hard disk drives. For optimal performance,
install identical drives of the same model and capacity when creating a disk array.

Installing Serial ATA (SATA) hard disks
To install the SATA hard disks for a RAID configuration:

1. Install the SATA hard disks into the drive bays.
2. Connect the SATA signal cables.
3. Connect a SATA power cable to the power connector on each drive.

R Refer to the RAID controllers user manual in the motherboard support DVD for
detailed information on RAID configurations. See section 5.2.5 Manual menu.
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5.5.2 NVIDIA® MediaShield RAID configurations

The motherboard includes a high performance RAID controller integrated in the
NVIDIA® nForce™ 590 SLI southbridge chipset. It supports RAID 0, RAID 1, RAID
0+1, RAID 5 and JBOD for six independent Serial ATA channels.

Setting the BIOS RAID items
After installing the hard disk drives, make sure to set the necessary RAID items in
the BIOS before setting your RAID configuration.

To set the BIOS RAID items:

1. Boot the system and press <Del> during the Power-On Self-Test (POST) to
enter the BIOS Setup Utility.

2. From the Main > Serial ATA Configuration menu item in the BIOS set the
nVidia RAID Function item to Enabled.

3. Select and enable the SATA drive(s) that you want to configure as RAID. See
section “4.4.7 Onboard Device Configuration” for details.

Save your changes and Exit Setup.

&

Make sure to re-enter your NVRAID settings after the CMOS is cleared;
otherwise, the system will not recognize your RAID setup.

% +  For detailed descriptions on the NVIDIA® RAID configuration, refer to the

“NVIDIA® RAID User’s Guide” found in your motherboard support DVD.

+ When using Windows 2000 operating system, make sure to install the
Windows 2000 Service Pack 4 or later versions.
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Entering the NVIDIA® MeidaShield RAID utility
To enter the NVIDIA® RAID utility:

1. Boot up your computer.
2. During POST, press <F10> to display the main menu of the utility.
may not exactly match the items on your screen.

NVIDIA RAID Utility Oct 5 2004
- Define a New Array -

RAID Mode: Striping Block:

R The RAID BIOS setup screens shown in this section are for reference only, and

Free Disks Array Disks
Disk Model Name Loc Disk Model Name

[F6] Back [F7] Finish [TAB] Navigate [{|] Select [ENTER] Popup

At the bottom of the screen are the navigation keys. These keys allow you to move
through and select menu options.

Creating a RAID Volume

To create a RAID volume:

1. From the NVIDIA® RAID utility Define a New Array menu, select RAID Mode
then press <Enter>. The following submenu appears.

Use the up or down arrow keys to select a ]
RAID mode then press <Enter>.

Striping

Stripe Mirroring

Spanning
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2. Press <TAB> select the Striping
Block then press <Enter>. The
following submenu appears:

If you selected Striping or Stripe Mirroring, use the up or down arrow keys to
select the stripe size for your RAID 0 array then press <Enter>.The available
values range from 8 KB to 128 KB. The default selection is 128 KB. The strip
value should be chosen based on the planned drive usage.

+ 8 /16 KB - low disk usage
* 64 KB - typical disk usage
+ 128 KB - performance disk usage

R TIP: For server systems, we recommend using a lower array block size. For
multimedia computer systems used mainly for audio and video editing, we
recommend a higher array block size for optimum performance.

3. Press <TAB> to select the Free Disks area. Use the left or right arrow keys to
assign the array disks.

4.  Press <F7> to create RAID set. The following message box appears.

Clear disk data?

5. Press <Y>to clear the selected disks or <N> to proceed without clearing the
disks. The following screen appears.

/é \ Take caution in using this option. All data on the RAID drives will be lost!
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NVIDIA RAID Utility Oct 5 2004
- Array List -

Boot Id Status Vendor Array Model Name

No 4 Healthy NVIDIA MIRROR  XXX.XXG

[Ctrl-X]Exit [f|]Select [B]Set Boot [N]New Array [ENTER]Detail

Anew set of navigation keys is displayed on the bottom of the screen.
6. Press <Ctrl+X> to save settings and exit.

Rebuilding a RAID array

To rebuild a RAID array:

1. From the Array List menu, use the up or down arrow keys to select a RAID
array then press <Enter>. The RAID Array details appear.

Array 1 : NVIDIA MIRROR XXX.XXG
- Array Detail -

RAID Mode: Mirroring
Striping Width: 1 Striping Block: 64K

Adapt Channel M/S Index Disk Model Name Capacity

2 1 Master 0 P.8:0.0.0.0.0.0.0.0.0.0.0.0.0.0.0.4 XXX .XXGB
! 0 Master 1 P.8:0.0.0.0.0.0.0.0.0.0.0.0.0.0.0.4 XXX .XXGB

[R] Rebuild [D] Delete [C] Clear Disk [ENTER] Return

ASUS M2N32-SLI Premium Vista Edition 5-45



A new set of navigation keys is displayed on the bottom of the screen.
2. Press <R>to rebuild a RAID array. The following screen appears.

Array 1 : NVIDIA MIRROR XXX.XXG
- Select Disk Inside Array -

RAID Mode: Mirroring
Striping Width: 1 Striping Block: 64K

Adapt Channel M/S Index Disk Model Name Capacity

Master 0 XXXXXXXXXXXXXXXXX XXX .XXGB
Master 1 XXXXXXXXXXXXXXXXX XXX.XXGB

[1|] Select [F6] Back [F7] Finish

3. Use the up or down arrow keys to select a RAID array to rebuild, then press
<F7>. The following confirmation message appears.

Rebuild array?

[ENTER] OK [ESC] Cancel

Press <Enter> to start rebuilding array or press <Esc> to cancel.
5.  After the rebuild process, the Array list menu appears.
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Deleting a RAID array

To delete a RAID array:

1.
array then press <Enter>. The RAID Array details appear.

Array 1 : NVIDIA MIRROR XXX.XXG
- Array Detail -

RAID Mode: Mirroring

Striping Width: 1 Striping Block: 64K

Adapt Channel M/S Index Disk Model Name

Capacity

Master 0 XXXXXXXXXXXXXXXXX XXX .XXGB
Master 1 XXXXXXXXXXXXXXXXX XXX .XXGB

[R] Rebuild [D] Delete [C] Clear Disk [ENTER] Return

A new set of navigation keys is displayed on the bottom of the screen.

Press <D> to delete a RAID array. The following confirmation message
appears.

2.

Delete this array?

[Y] YES [N] No

3.  Press <Y>to delete array or press <N> to cancel.

//f\ \ Take caution in using this option. All data on the RAID drives will be lost!

4. If you selected Yes, the Define a New Array menu appears.
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Clearing a disk data

To clear disk data:

1. From the Array List menu, use the up or down arrow keys to select a RAID
array then press <Enter>. The RAID Array details appear.
Array 1 : NVIDIA MIRROR XXX.XXG
- Array Detail -

RAID Mode: Mirroring

Striping Width: 1 Striping Block: 64K

Adapt Channel M/S Index Disk Model Name Capacity
Master 0 XXXXXXXXXXXXXXXXX XXX.XXGB
Master 1 XXXXXXXXXXXXXXXXX XXX.XXGB

[R] Rebuild [D] Delete [C] Clear Disk [ENTER] Return
A new set of navigation keys is displayed on the bottom of the screen.
2.

Press <C> to clear disk. The following confirmation message appears.

Clear disk data?

[Y] YES [N]

5. Press <Y> to clear the disk data or press <N> to cancel.

/é\ \ Take caution in using this option. All data on the RAID drives will be lost!
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5.5.3 Silicon Image RAID configurations

The Silicon Image RAID controller supports RAID 0, RAID 1 and JBOD
configurations. Use the Silicon Image RAID utility to configure a disk array.

Setting the BIOS RAID items
After installing the hard disk drives, make sure to set the necessary RAID items in
the BIOS before setting your RAID configuration.

To set the BIOS RAID items:

1. Boot the system and press <Del> during the Power-On Self-Test (POST) to
enter the BIOS Setup Utility.

2. From the Advanced > Onboard Devices Configuration menu item in the
BIOS set the Silicon Image Controller item to RAID Mode. See section “4.4.6
Onboard Devices Configuration” for details.

3. Save your changes and Exit Setup.

Launching the Silicon Image Array Management Software

Launch the Silicon Image Array Management software from Windows® XP by
clicking the Start button and selecting All Programs > Silicon Image > Sam

R For details on the Silicon Image SATARaid™ RAID configuration, refer to the
“Sil3132 User Guide” in your motherboard support DVD.
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Entering the Silicon Image BIOS RAID Configuration Utility

To enter the Silicon Image BIOS RAID configuration utility:
1. Boot up your computer.
2. During POST, press <Ctrl+S> or <F4>.

R The RAID BIOS setup screens shown in this section are for reference only, and
may not exactly match the items on your screen.

RAID Configuration Utility - Silicon Image Inc. Copyright (C) 2004

= MAIN MENU HELP
Create RAID set Press “Enter” to create
Delete RAID set RAID set

Rebuild Raidl set
Resolve Conflicts
Low Level Format
Logical Drive Info

= PHYSICAL DRIVE LOGICAL DRIVE
0  XXXXXXXKXXXX XXXXXXMB STXXXKXXXKXX XXXXXXMB
1  XXXXXXKXXXX XXXXXXMB STXXXKXXXKXX XXXXXXMB
2 XXXXXKXXKXX XXXXXXMB STXXXKXXXKXX XXXXXXMB
3 XXXXXKXXKXX XXXXXXMB STXXXKXXXKXX XXXXXXMB

1|:Select Menu ESC:Previous Menu Enter:Select Ctrl-E:Exit

The Main Menu on the upper left corner allows you to select an operation to be
performed. The Main Menu options include the following:

Create RAID set - creates a new legacy RAID set or allocates spare drives.
Delete RAID set - deletes a RAID set or deallocates a spare drive.

Rebuild RAID1 set - rebuilds a RAID 1 set (e.g., swapped drives).
Resolve Conflicts - automatically restores disrupted drives on a RAID set.

Low Level Format - creates a pattern of reference marks on a drive. Formatting the
disks erases all data previously stored in the drive.

Logical Drive Info -shows the current configuration of each RAID set.

On the upper right corner of the screen is the Help message box. The message
describes the function of each menu item. At the bottom of the screen is the
legend box. The keys on the legend box allow you to navigate through the setup
menu options. The following lists the keys found in the legend box and their
corresponding functions.

1l . Select/Move to the next item
ESC . Previous Menu

Enter : Select

Ctrl-E : Exit

Chapter 5: Software support



Creating a RAID 0 set (Striped)

To create a RAID set:

1. From the Silicon Image
configuration utility main
menu, select Create RAID
set then press <Enter> to
display an option menu.

2. Select RAID 0 then press
<Enter> to display the
following.

— MAIN MENU

Delete RAID set
Rebuild Raidl set
Resolve Conflicts
Low Level Format
Logical Drive Info

RAIDO

RAID1
SPARE DRIVE

CONCATENATION

= MAIN MENU

Auto configuration

Manual configuration

3. Select your desired method of configuration.

Auto configuration

a. Select Auto Configuration the press <Enters.

b. The utility prompts a message to input the RAID size, use the up or down
arrow keys to set the RAID size then press <Enter>.

c. Press <Y> to confirm or <N> to return to the Main Menu.

At

Manual configuration

a. Select Manual
configuration and
press <Enter>. The
following pop-up menu
appears.

b. Use the up or down
arrow keys to select
a chunk size
appropriate to your
drive usage then press
<Enter>.

By default, Auto configuration sets the stripe size to 64K and sets the logical
drives based on the physical drives installed.

= MAIN MENU

chunk size

Auto configuration
Manual configuration
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AN

TIP: For server systems, we recommend using a lower array block size. For
multimedia computer systems used mainly for audio and video editing, we

recommend a higher array block size for optimum performance.

c. The selection bar moves to
the Physical Drive menu.
Using the up or down arrow
keys, select a drive then
press <Enter> to set the
first drive of the RAID set.

— PHYSICAL DRIVE

0 XXXXXXXXXXX XXXXXXMB

1 XXXXXXXXXXX XXXXXXMB
2 XXXXXXXXXXX XXXXXXMB
3 XXXXXXXXXXX XXXXXXMB

d. Repeat step c to set the second, third, and fourth drive. The number of
available drives depend on the installed and enabled physical drives in

the system.

e. The utility prompts a message to input the RAID size, use the up or down

arrow keys to set the RAID size then press <Enter>.

f. Press <Y> to confirm or

<N> to return to the Main Menu.

Creating a RAID 1 set (Mirrored)
To create a RAID 1 set:

1.

From the Silicon Image
configuration utility main
menu, select Create RAID
set then press <Enter>.
The following sub-menu
appears.

Select RAID 1 then press
<Enter> to display the
following.

= MAIN MENU

Create RAID set

Delete RAID set
Rebuild Raidl set
Resolve Conflicts
Low Level Format
Logical Drive Info

RAIDO

RAID1

SPARE DRIVE

CONCATENATION

= MAIN MENU

iAuto configuration

Manual configuration
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3. Select your desired method of configuration.
Auto configuration
a. Select Auto Configuration then press <Enter>.

b. The utility prompts a message to input the RAID size, use the up or down
arrow keys to set the RAID size then press <Enter>.

c. Press <Y> to confirm or <N> to return to the Main Menu.

R +  Auto-configuration creates a RAID 1 set without a backup copy of the
current source disk data.

When migrating a single hard disk drive to a RAID 1 set, use of the Manual
configuration is recommended.

Manual configuration

a. Select Manual
configuration and press

— PHYSICAL DRIVE

.
<Enter>. The selection TR ST
bar moves to the Physical 2 oo “EEOBCT

. 3 XXXXXXXXXXX XXXXXXMB
Drives menu.

b. Using the up or down arrow
keys, select the source drive
and press <Enter>.

c. Repeat step b to select the target drive.

d. After selecting the = MAIN MENU
source and target Auto configuration

drives, the following
Op-Up menu appears.
Pop-tp men app

Create without data copy

R +  The Create with data copy option allows you to copy the current data from
the source drive to the mirror drive.

Select Create with data copy if you have important data in your source
drive.

The Create without data copy option disables the disk copy function of the
Mirrored set.

+  If you selected Create without data copy, the RAID 1 set must be repartitioned
and reformatted to guarantee the consistency of its contents.
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e. If you selected = MAIN MENU

Create with data Auto configuration
copy, the following
pop-up menu

appears.

R The online copy option automatically copies the data to the target drives on the
background while writing to the source drives. The offline copy option allows you
to copy the contents of the source drive to the target drives now.

f.  Use the up or down arrow keys to select desired copy method, then press
<Enter>.

g. The utility prompts a message to input the RAID size, use the up or down
arrow keys to set the RAID size then press <Enter>.

h. Press <Y> to confirm or <N> to return to the Main Menu.

/ A copy progress appears if you previously selected offline copy.
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Creating a CONCATENATION set
To create a CONCATENATION set:

1. From the Silicon Image

— MAIN MENU
configuration utility main
menu, select Create RAID | Delete RAID set. RAIDO
Rebuild Raidl set RAID1

set then press <Enter>.

2. From the sub-menu
Select CONCATENATION
then press <Enter>.

Resolve Conflicts
Low Level Format
Logical Drive Info

SPARE DRIVE

CONCATENATION

3.  The selection bar moves to the
Physical Drive menu. Using the up
or down arrow keys, select a drive
then press <Enter> to set a drive
for the RAID set.

4.  The utility prompts a message to
input the RAID size, use the up or
down arrow keys to set the RAID
size then press <Enter>.

— PHYSICAL DRIVE

0  XXXXXXXXXXX XXXXXXMB

1 XXXXXXXXXXX XXXXXXMB
2 XXXXXXXXXXX XXXXXXMB
3 XXXXXXXXXXX XXXXXXMB

5.  Press <Y> to confirm or <N> to return to the Main Menu.

7
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5.6 Creating a RAID driver disk

Afloppy disk with the RAID driver is required when installing Windows® 2000/XP/
Vista operating system on a hard disk drive that is included in a RAID set.

To create a RAID driver disk:

. Place the motherboard support DVD into the DVD-ROM drive.
2. Select Make Disk tab.

From the Make Disk menu, select the RAID driver disk you want to create or
browse the contents of the support DVD to locate the driver disk utility.

w

% Refer to section 5.2.4 Make Disk menu for details.

4.  Insert floppy disk to floppy disk drive.
5. Follow succeeding screen information to complete process.
6.  Write-protect the floppy disk to avoid computer virus infection.

To install the RAID driver:
1. During the OS installation, the system prompts you to press the F6 key to
install third-party SCSI or RAID driver.

2. Press <F6> then insert the floppy disk with RAID driver into the floppy disk
drive.

3. Follow the succeeding screen instructions to complete the installation.

/ Due to chipset limitation, the Serial ATA ports supported by the NVIDIA chipset
doesn't support Serial Optical Disk Drives (Serial ODD) under DOS.
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This chapter tells how to install SLI-ready
PCI Express graphics cards.

NVIDIA® SLT'
technology support



6.1
6.2

Overview......

Dual graphics cards setup.
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6.1 Overview

The motherboard supports the NVIDIA® SLI™ (Scalable Link Interface)-Intel® Edition
technology that allows you to install two identical PCI Express” x16 graphics cards.
Follow the installation procedures in this section.

Requirements

. You should have two identical SLI-ready graphics cards that are NVIDIA®
certified.

+  Make sure that your graphics card driver supports the NVIDIA® SLI™
technology. Download the latest driver from the NVIDIA website (www.nvidia.
com).

. Make sure that your power supply unit (PSU) can provide at least the
minimum power required by your system. See “9. ATX power connectors” on
page 2-31 for details.

R + The NVIDIA® SLI" technology supports Windows® XP™ 32-bit/64bit
operating system. Visit the NVIDIA website (www.nvidia.com) for the
NVIDIA® SLI™ technology under Windows® Vista™

Visit the NVIDIA zone website (http://www.nzone.com) for the latest certified
graphics card and supported 3D application list.
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6.2 Dual graphics card setup
6.2.1 Installing SLI-ready graphics cards

R Install only identical SLI-ready graphics cards that are NVIDIA®-certified.
Different types of graphics cards will not work together properly.

To install the graphics cards:

1. Prepare two graphics cards. Each graphics card should have goldfingers for
the SLI connector.

Goldfingers

2. Remove the metal bracket covers opposite the two PCI Express x16 slots.
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3. Insert one graphics card into either the blue or black slot. Make sure that the
card is properly seated on the slot.

4.  Insert the second graphics card into the other slot. Make sure that the card is
properly seated on the slot.

R If required, connect an aucxiliary power source to the PCI Express graphics
cards.
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6-4

5. Align and insert the SLI connector to the goldfingers on each graphics card.
Make sure that the connector is firmly in place.

6.  When installing two VGA cards using a 20-pin ATX PSU with sufficient+12v
capability, we recommend that you connect the auxillary power source from
the power supply to the graphics card. Refer to the PSU documentation for
dual VGA power requirements.

7. Connect a VGA cable or a DVI-I cable to the graphics card/s.

R We recommend to install an additional chassis fan for better thermall
environment.
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6.2.2 Installing the device drivers

Refer to the documentation that came with your graphics card package to install
the device drivers.

R Make sure that your PCI Express graphics card driver supports the NVIDIA SLI

technology. Download the latest driver from the NVIDIA website (www.nvidia.
com).

6.2.3 Enabling the multi-GPU feature in Windows”

After installing your graphics cards and the device drivers, enable the
Multi-Graphics Processing Unit (GPU) feature in the NVIDIA nView properties.

To enable the multi-GPU feature:

1. Click the NVIDIA Settings icon on
your Windows taskbar.
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NVIDIA Settings icon

2. From the pop-up menu, select
nView Desktop Manager then click ™) p—
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5. From the Display Properties dialog
box, select the Settings tab then
click Advanced.

6. Select the NVIDIA GeForce tab.

7. Click the slider to display the
following screen, then select the SLI
multi-GPU item.
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Click the Enable SLI multi-GPU check box.

9. Click OK when done.
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